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Abstract 

Hyperthermus butylicus is one of the few hyperthermophilic (organisms that thrive in temperatures 

80C and above) archaea that can produce 1-butanol as a major fermentation end-product. The 

reported end-products (acetone, isopropanol, acetate, and butyrate, in addition to 1-butanol) bare 

similarity to that of solvent producing clostridial species, and an alcohol dehydrogenase (ADH) 

(Hbut_0414) is found to be responsible for the production of 1-butanol in H. butylicus. It was not 

clear, however, if ethanol is produced and which pathway(s) and key enzymes are involved in the 

solvent production by H. butylicus. To gain a greater understanding of the metabolism of this 

microorganism, the aims of this thesis were to examine its growth and solvent production. 

 

Through optimization experiments for H. butylicus growth conditions, it was determined that a pH of 

7.0, sulfur concentration of 10.0 g/L, and H2 pressure of 3.0 atm (over-pressurized) resulted in the 

highest growth (> 1.0 x 108 cells/mL). It was found that precipitated sulfur from Sigma-Aldrich was 

strictly required. Using gas chromatography, the fermentation end-products ethanol, acetone, 

isopropanol, and 1-butanol in batch cultures of H. butylicus were detected. The synthesis of these 

solvents was found to be growth dependent where an increase in growth correspondingly resulted in 

an increase in solvent production, demonstrating significance between metabolic activity and growth 

in the microorganism. The addition of sodium acetate and sodium butyrate in the growth media 

affected both the growth and solvent production. In cultures supplemented with acetate, a decrease in 

growth was observed compared to cultures supplemented with butyrate and without any 

supplementation. Supplementing the growth medium with 5- and 15-mM of sodium acetate and 

sodium butyrate resulted in an increase in ethanol and 1-butanol, respectively, indicating that H. 

butylicus could utilize these organic acids for producing their corresponding alcohols.  

 

Bioinformatic analyses (BLAST, HMM) showed no significant similarity for key solvent-producing 

enzymes was found in H. butylicus when searched against enzymes produced by other existing 

butanol producing organisms. It is concluded that H. butylicus is the first hypertherthermophile 

capable of acetone-butanol-ethanol (ABE) fermentation, but the responsible pathway remains 

unknown. It is proposed that a novel butanol production pathway in H. butylicus exists, which may 

share similarities to the ABE pathway in C. acetobutylicum, keto-acid pathway in Saccharomyces 

cerevisiae, butyraldehyde dehydrogenase pathway in C. saccharoperbutylacetonicum N1-4, the two-
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step PDC/ADH pathway in Thermococcus guaymasensis, and an organic acid reduction pathway 

involving an aldehyde:ferredoxin oxidoreductase.  

 

Further investigation is required to enhance the understanding of H. butylicus’ metabolism. Future 

studies for the biochemical determination of key enzymes, quantifying the amount of organic acids 

consumed, and the pH dependency of solvent production in the presence and absence or organic acids 

will provide insight into revealing pathways responsible for the solvent production in H. butylicus. 
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1.0 Introduction 

1.0 Microbial production of alcohols 

1.1 Alcohol fermentation 

Alcohol fermentation is a biological process that converts biomass into one or more different 

alcohols by a microorganism. Fermentation products are predominately produced from the 

metabolic intermediate pyruvate formed via central metabolic pathways involved in carbohydrate 

catabolism (Hoelzle et al. 2014) (see: Section 1.2). Depending on the substrate and fermentative 

organism in question, the type of alcohol fermentation can vary. The importance of alcohol 

fermentation spans from its applications in biofuel production and biotechnology to its major 

role in alcoholic beverages and fermented foods, which will be further discussed in the following 

sections. 

1.1.1 Alcohol fermentation for consumption 

Microbial solvent production is widely used in food fermentation and has long been practiced 

across cultures as a means of preserving, producing, or flavouring food, as well as producing 

beverages (Katz 2012). In recent years, fermented foods have gained particular attention due to 

their various health benefits in addition to extending the “shelf life” (Soni and Dey 2014). The 

first fermentation event is predicted to have occurred “by accident”, resulting in a natural 

phenomenon that human cultures have observed and subsequently learned from (Katz 2012). 

Biochemically, fermentation is a pathway where the NADH that is produced is re-oxidized by 

the intermediate that is produced in the pathway. Louis Pasteur, a French chemist, was the first to 

report the microbial nature of fermentation in 1857 (Durre 1998) and as a consequence of his 

observations, the scientific underpinnings of alcoholic fermentation were established. One of the 

earliest records showing evidence of alcohol fermentation comes from a study by McGovern et 

al. (2004) who identified residues of alcohol in pottery pieces dating back 9,000 years that 

originated from the early Neolithic village of Jiahu in China (McGovern et al. 2004). The 

fermented beverage was reported to be a mixture of rice, honey, and fruit suggesting the mixing 

of carbohydrates with yeast sources was done intentionally (McGovern et al. 2004; Katz 2012). 

The process of fermentation was likely influenced by the environment and varies depending on 

the region (i.e., the resources available and microbial communities present). For example, millet 



 

  2 

and rice, which are naturally found growing in regions of China underwent alcohol fermentation 

by molds that digested the substrates into simple sugars (Katz 2012). Similarly, barley and wheat 

which are found in the Middle East uses a different method of germination called “malting”; a 

process that is used to digest sugars for alcohol fermentation (Tanno and Willcox 2012). The 

utilization of microorganisms for food fermentation is one example demonstrating the potentially 

multifaceted benefit of utilizing microorganisms for human well-being. 

1.1.2 Biofuels 

Depletion of the world’s petroleum supply has spurred increased interest in finding alternative 

and renewable sources of energy including the possibility of producing biofuels from microbial 

fermentation. Approximately 40% of the world’s total energy consumption is in the form of 

liquid fuels, making biofuels both an attractive and practical alternative to fossil fuels (Tan et al. 

2008). With bioenergy predicted to be able to meet up to approximately one-third of the global 

energy demand by 2050 (Guo et al. 2015), a considerable amount of research focus on the 

microbial production of biofuels is expected. 

 

Research efforts to develop alternative fuel sources have long focused on bioethanol as it is an 

established biotechnological process and due to its production feasibility (Jin et al. 2011; Aditiya 

et al. 2016). Alongside biodiesel, bioethanol is the most widely used alternatives to petrol-based 

fuels (Serrano-Ruiz et al. 2011). Bioethanol production has been steadily increasing every year, 

with global production reported at nearly 30 billion gallons in 2019 compared to approximately 

20 billion gallons in 2009 (Karimi et al. 2021). Currently, the industrial production of bioethanol 

relies primarily on food sources as raw materials (Wang et al. 2021). This presents challenges as 

the source material for bioethanol can also be used for the production of food and feed thus, 

bringing direct competition for food production. This can furthermore have an impact on food 

supply and potentially increase food prices (Obergruber et al. 2021). With the challenges that 

exist in bioethanol production, there has been an increased desire for alternative bio-solvents 

from microbial fermentation with biobutanol in the forefront.  

 

Butanol (C4H9OH), or butyl alcohol, is a four-carbon alcohol mixture, composed of four 

structural isomers (n-butanol/1-butanol, secondary-butanol/2-butanol, tert-butanol, and iso-
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butanol) (Pan et al. 2020). It is commonly used as a solvent in cosmetic and pharmaceutical 

industries for the production of antibiotics, vitamins, and hormones. In addition, butanol is a 

chemical intermediate for the synthesis of methyl methacrylate and butyl acrylate (monomeric 

precursors of polymers) which are important compounds used for manufacturing a wide range of 

products including plastics (Lee at al. 2008; Garcia et al. 2011). Biobutanol is considered to be a 

more desirable biofuel than bioethanol because of its advantageous chemical properties: 

biobutanol has a higher energy content, is less explosive and volatile, has a higher flash point, 

and does not readily absorb moisture (Garcia et al. 2011; Ndaba et al. 2015), making biobutanol 

comparatively safter to handle than bioethanol. Additionally, butanol can be used in either pure 

or mixed concentrations with gasoline due to its higher energy density and lower polarity 

(Sarathy et al. 2012), while ethanol can only be mixed up to 85% with gasoline (Durre 2007). It 

is beneficial to mix or “blend” biofuels with gasoline because the alcohol acts as a fuel additive, 

allowing the fuels to burn cleaner and produce lower levels of CO2 emissions (Varoil et al. 

2014). Despite efforts to find alternatives to non-renewable fuel sources, fossil fuels continue to 

make up approximately 83% of the primary energy consumed globally (Pugazhendhi et al. 

2019). Both bioethanol and biobutanol possess a major advantage over petroleum-based fuels 

which is that they “generate low net [greenhouse gas] emissions” when produced from 

lignocellulosic materials (Nigam and Singh 2011), and therefore have a lower environmental 

impact. Additionally, butanol can be produced from a variety of biomass feedstocks (including 

waste) reducing the competition for food production, unlike bioethanol (Abdehagh et al. 2014) 

(see: Section 2.1).  

 

One difficulty in industrial biobutanol production is the severe toxicity of the solvent on the 

producing microorganism. Since butanol is toxic to microorganisms in high concentrations, the 

level of butanol tolerance of the producing microorganism directly impacts the total butanol 

production (Knoshaug and Zhang 2009). For example, Clostridium acetobutylicum D64 can 

produce up to 13 g/L of butanol, however, is only able to tolerate a maximum of 2% (i.e., 20 g/L) 

of butanol (v/v) (Liu et al. 2012). Biobutanol also has a low production rate (approximately 30 

times lower) relative to bioethanol (Anitha et al. 2020), with reports showing < 0.3 g/L/h 

production rate for biobutanol by Clostridial species compared to 3.46 g/L/h for bioethanol by S. 

cerevisiae (Wang et al. 2017; Azhar et al. 2017). Research is directed to overcoming these 
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challenges through methods such as finding an efficient separation technique to recover butanol, 

enhancing butanol tolerance and yield in genetically altered strains, and genetic engineering to 

increase butanol production, among others (Liu et al. 2012; Gonzalez-Ramos et al. 2013). 
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1.2 Metabolic pathways for butanol production and key enzymes involved 

Industrial solvent production by microorganisms is largely dominated by mesophilic 

microorganisms. For example, the gram-negative bacterium Clostridium acetobutylicum is a 

well-known industrial acetone-butanol-ethanol (ABE) producer (Lee et al. 2008; Gheshlaghi et 

al. 2009), while strains of Saccharomyces cerevisiae (yeast) and Zymomonas mobilis (gram-

negative) are commonly used to produce ethanol from sugar- and starch-based feedstocks 

(Doran-Peterson et al. 2008; Xia et al. 2019). Solvent production in mesophiles generally begins 

with simple sugars, such as glucose, which is then converted into pyruvate via either the 

Embden-Meyerhof-Parnas (EMP) pathway, the Pentose Phosphate (PP) pathway or, the Entner-

Doudoroff (ED) pathway (Fig. 1) (Xia et al. 2019). These three pathways aid in the breakdown 

of glucose for energy and carbon metabolism in a process called glycolysis, which is central to 

all domains of life. The EMP pathway has modified forms especially within anaerobes, where 

the pathway is used to synthesize ethanol and CO2, as opposed to in aerobes where the pathway 

is used to produce pyruvate for the tricarboxylic acid cycle (TCA). The PP pathway oxidizes the 

glucose-6-phosphate intermediate from the EMP pathway to produce NADPH and pentose 

phosphates. These two pathways function to produce ATP, NAD(P)H, and the biosynthetic 

precursors for amino acids, nucleotides, and fatty acids (Chen et al. 2016). The ED pathway is 

similar to the EMP pathway, however, utilizes two key enzymes that are unique to this pathway 

(6-phosphogluconate dehydrates and 2-keto-3-deoxygluconate-6-phosphate aldolase). Solvent 

production in Z. mobilis, a facultative anaerobe, is unique in that it exclusively uses the ED 

pathway for ethanol fermentation (Conway 1992; Xia et al. 2019).  

 

While industrial microbial solvent production is currently largely dominated by mesophilic 

microorganisms, there are several hyperthermophiles that possess the ability to produce solvents 

as their major metabolic end-products. In fact, three hyperthermophiles are known to produce 

butanol naturally, Thermococcus ES-1, Pyrodicitum abyssi sp. nov., and Hyperthermus butylicus, 

however, the pathways for butanol production in these organisms are currently unknown (Ma et 

al. 1995; Pley et al. 1991; Zillig et al. 1990). 
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Figure 1. Schematic diagram of three pathways for glycolysis: EMP pathway, PP pathway (dotted lines), and the ED pathway (solid line). 

PFK: 6-phosphofructokinase; EDD: 6-phosphogluconate dehydratase; EDA: aldolase. (Modified from Wolfe 2015).  
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1.2.1 Acetone-butanol-ethanol (ABE) pathway in Clostridium acetobutylicum 

C. acetobutylicum is a well-known industrial producer of biobutanol and the most extensively 

studied solventogenic bacterial species (Lee et al. 2008). Its pathway for solvent production 

(ABE pathway) involves a two-stage process, the acidogenesis phase and the solventogenic 

phase, and begins with the conversion of a simple sugar (glucose) into pyruvate (Fig. 2). 

Pyruvate is converted into acetyl-CoA by the concurrent reduction of ferrodoxin by pyruvate-

ferredoxin:oxidoreductase (POR) then, following the condensation of two acetyl-CoA molecules, 

acetoacetyl-CoA is produced via the action of the enzyme acetyl-CoA-acetyltransferase. The 

accumulation of organic acids (acetic acid and butyric acid from acetyl-CoA) causes the pH of 

the culture to become more acidic, resulting in the metabolism entering the solventogenic phase. 

The conversion of organic acids (acetate and butyrate) into their corresponding solvents (ethanol 

and butanol, respectively) stops the production of acid, resulting in a decrease in cell growth and 

an increase in pH (Lee et al. 2008).   
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Figure 2. Schematic diagram of ABE fermentation pathway for the production of butanol by C. acetobutylicum. POR: pyruvate:ferredoxin 

oxioreductase; AK: acetate kinase; PTA: phosphotrans-acetylase; AADH: acetaldehyde dehydrogenase; ADH: alcohol dehydrogenase; ACAT: 

acetyl-coenzyme A acetyltransferase/Thiolase; ADC: acetoacetate decarboxylase; HBD: beta-hydroxybutyryl-CoA dehydrogenase; BK: butyrate 

kinase; PTB: phosphotrans-butyrylase; BDH: butyryl-CoA dehydrogenase; BADH: butryladehyde dehydrogenase; BDH: butanol dehydrogenase. 

(Modified from Garcia et al. 2011).
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1.2.2 Butanol and isobutanol pathway in Saccharomyces cerevisae   

A pathway for 1-butanol production has been found to occur naturally in a strain of S. cerevisiae, 

called the “glycine degradation” pathway (Branduardi et al. 2013; Swidah et al. 2018). This 

pathway utilizes intermediates from amino acid biosynthesis (glycine) as a substrate for the 

production of 1-butanol, and additionally, can use serine for the production of iso-butanol in a 

similar way. Both pathways involve the deamination of the amino acid (glycine and serine) to 

ultimately produce alpha-keto valerate and alpha-isoketovalerate, respectively, then finally into 

their corresponding alcohols (1-butanol and isobutanol, respectively) via the Elrich pathway 

(catabolism of amino acids to alcohols) (Branduardi et al. 2013). (Fig. 3). The “glycine-butanol” 

pathway is alternatively referred to as the “keto-acid” pathway (or “2-keto acid pathway”) 

(Jambunathan & Zhang 2014; Si et al. 2014) as the key intermediates for the amino acid 

biosynthetic pathways are alpha-keto-acids (see: Section 1.2.4).  

 

 
 

Figure 3. Schematic diagram showing a proposed 1-butanol and isobutanol production pathway by 

S. cerevisiae. Reduction of butanal to butanol is shown as a single step. goxB: glycine oxidase; SHM1, 

SHM2: serine hydroxymetyl-transferase; MLS1, DAL7: malate synthase; CHA1: serine deaminase; 

LEU2: beta-isopropylmalate dehydrogenase; PDC1,5,6: pyruvate decarboxylase; ADH2: alcohol 

dehydrogenase. (Modified from Branduardi et al. 2013). 



 

  10 

1.2.3 Bioconversion of carboxylic acids to alcohols 

ABE producing Clostridia are known to produce butyrate and/or 1-butanol through the 

intermediate butyryl-CoA, however, researchers have found an alternative mechanism for 1-

butanol production by a Clostridium spp. that can convert a carboxylic acid, specifically butyric 

acid, directly to 1-butanol (Al-Shorgani et al. 2012). Known as a “hyper-butanol-producing-

strain”, C. saccharoperbutylacetonicum N1-4 that was isolated and used for industrial butanol 

production has been recently sequenced (Wang et al. 2017). This bacterium is unique in that it 

possesses the ability to utilize butyric acid as a substrate to produce 1-butanol. Typically, butyric 

acid inhibits cell growth thus limiting solvent production, however, in combination with glucose, 

butanol production was enhanced more than 40-fold in C. saccharoperbutylacetonicum N1-4 

(Al-Shorgani et al. 2012). Without glucose addition, butanol production still increased when at 

least 1 g/L of butyric acid was added (0.28 g/L to 0.80 g/L). However, when 5 g/L of glucose 

and 1 g/L butyric acid were added butanol production increased two-fold (1.61 g/L) (Al-

Shorgani et al. 2012). This suggests that the presence of butyric acid triggered the solventogenic 

pathway in this bacterium resulting in an increased butanol production. Researchers also reported 

that presence of butyric acid inhibited cell growth through enhanced butanol production (Al-

Shorgani et al. 2012). 

 

There are two proposed CoA-transferase pathways for butanol production by C. 

saccharoperbutylacetonicum N1-4 from the bioconversion of butyrate (Fig. 4). The first is the 

reverse pathway of butyrate production where butyrate is converted to the butyryl-CoA 

intermediate by the butyrate-CoA-transferase enzyme. Butyryl-CoA is then converted to 

butyraldehyde and subsequently butanol through the enzymes butyraldehyde dehydrogenase 

(BADH) and butanol dehydrogenase (BDH) (Fig. 4A), respectively, which is similar to butanol 

production in C. acetobutylicum (Fig. 2). The second pathway involves the conversion of 

butyrate to butyryl-phosphate and then to the intermediate butyryl-CoA through the action of the 

enzyme butyrate kinase and subsequently phosphotransbutyrylase (Al-Shorgani et al. 2012). For 

butanol production, butyryl-CoA is converted the same way as the first hypothesized pathway – 

butyraldehyde then butanol by BADH and BDH (Fig. 4B). 
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Figure 4. Schematic diagram showing two potential butanol production pathways (A and B) within the bacterium C. 

saccharoperbutylacetonicum N1-4. CoAT: CoA transferase, BADH: butylaldehyde dehydrogenase, BDH: butanol dehydrogenase, BK: butyrate 

kinase, PTB: phosphotransbutyrylase. (Modified from Al-Shorgani et al. 2012).
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The reduction of organic acids was first observed in the solventogenic bacterium Clostridium 

thermoaceticum, where it was found that C. thermoacetium possessed the ability to reduce a 

variety of tested carboxylic acids (i.e., acetate, propionate, butyrate) into their corresponding 

aldehydes (i.e., ethanol, 1-propanol, 1-butanol) (White et al. 1989). The enzyme that catalyzed 

these reactions was reported to be what was termed a “carboxylic acid reductase (aldehyde 

dehydrogenase)" (White et al. 1989; Strobl et al. 1992). Another Clostridial spp. was found more 

recently to possess the ability to reduce organic acids, however, via an “aldehyde 

oxidoreductase-like” enzyme (Isom et al. 2015). Researchers found that C. ragsdalei could 

convert propionic, butyric, pentanoic, and hexanoic acids to the corresponding alcohols, 1-

propanol, 1-butanol, 1-pentanol, and 1-hexanol, respectively (Isom et al. 2015).  

 

Aldehyde:ferredoxin oxidoreductases (AORs) are a family of molybdenum or tungsten 

oxidoreductases isolated from strictly anaerobic microorganisms. They are involved in the 

reduction of an organic acid, that is either externally added or intermediately produced, to its 

corresponding alcohol in vivo (Huber et al. 1995; Nissen and Basen 2019). Most solvent 

producing microorganisms commonly convert pyruvate into acetaldehyde by a pyruvate 

decarboxylase or into the intermediate acetyl-CoA, with pyruvate dehydrogenase or 

pyruvate:ferredoxin oxidoreductase (see: Section 2.3.1) (Olson et al. 2015). Microorganisms that 

possess the AOR enzyme, however, may have this pathway in which the direct reduction of 

acetate to acetaldehyde is required (Nissen and Basen 2019) (Fig 5).  
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Figure 5. Schematic diagram showing a proposed pathway for reduction of organic acid to its 

corresponding alcohol by an aldehyde:ferredoxin oxidoreductase. AOR: aldehyde:ferredoxin 

oxidoreductase, ADH: alcohol dehydrogenase. (Modified from Nissen and Basen 2019). 

 

The first evidence of an AOR in a hyperthermophile was in Pyrococcus furiosis, however, the 

proposed role of the AOR was as a “glyceraldehyde-oxidizing enzyme” (Mukund and Adams 

1991). In another study, a synthetic route (“AOR pathway”) was successfully engineered into P. 

furiosis which allowed the organism to produce the corresponding alcohols when organic acids 

(acetate, butyrate, propionate, isobutyrate, valerate, isovalerate, caproate, phenylacetate) were 

exogenously supplemented into culture media (Basen et al. 2014). This was achieved by the 

insertion of the gene for bacterial ADH into P. furiosis (Basen et al. 2014).  
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1.2.4 Bioengineered metabolic pathways 

Metabolic engineering is the intentional manipulation/modification of genetic processes and 

pathways to maximize the yield of a compound of interest. It involves the manipulation of 

enzymatic, transport, and regulatory functions of the cell thus, requires organism(s) that will be 

modified to be fully sequenced and characterized (Koffas et al. 1999; Garcia-Granados et al. 

2019). This practice is commonly employed in industry to maximize the yield of a desired 

solvent. E. coli is a model organism for industrial solvent production as it is well-characterized 

with a wealth of genetic and physiological information, making the microbe a suitable host for 

making modifications (Atsumi et al. 2008). E. coli does not naturally produce 1-butanol as a 

fermentation product, however, this bacterium is often used as a host to clone and express genes 

for 1-butanol production (Atsumi et al. 2008; Branduardi et al. 2013) (Fig. 6). 

 

 

Figure 6. Schematic diagram of engineered Clostridium ABE production pathway in E. coli. E. coli 

metabolism (solid line), Clostridium (dotted line). Thl: acetoacetyl-CoA thiolase; Hbd: 3-hydroxybutyryl-

CoA dehydrogenase; Crt: crotonase; Bcd: butyryl-CoA dehydrogenase; Etf: electron transfer flavoprotein; 

AdhE2: aldehyde/alcohol dehydrogenase. (Modified from Atsumi et al. 2008) 
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The pathway for the metabolism of glucose to acetyl-CoA was maintained in E. coli, and the 

conversion from acetoacetyl-CoA to 1-butanol in C. acetobutylicum was introduced. Reports 

have shown that solvent yields in E. coli were similar to those obtained in Clostridia when 

engineered with the Clostridia butanol pathway (Atsumi et al. 2008). The keto-acid pathway 

(refer to: Section 1.2.2), another known pathway for 1-butanol production, has been successfully 

engineered into E. coli (Fig. 7), and is similar to the novel pathway found to be naturally 

occurring in S. cerevisiae (refer to: Fig. 3) 

 

                                
 

Figure 7. Schematic diagram of engineered keto-acid pathway in E. coli for 1-butanol production. 

LeuA: 2-isopropylmalate synthase; LeuCD: 2-isopropylmalate isomerase; LeuB: 2-isopropylmalate 

dehydrogenase. (Modified from Branduardi et al. 2013). 
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1.3 Hyperthermophiles 

Hyperthermophiles are a group of unique microorganisms that grow optimally and thrive in 

temperatures above 80C (Schonheit and Schafter 1995; van Wolferen et al. 2013). This group of 

mainly anaerobic, chemolithoautotrophic and heterotrophic microorganisms are the primary 

producers in these extremely hot environments, typically utilizing polypeptides as their main 

carbon and energy source (Huber and Stetter 1998). Most sulfate-reducing microorganisms are 

also primarily hyperthermophilic, with sulfate reduction considered to be one of the most ancient 

energetic pathways, and many organisms belonging to the archaeal phylum Crenarchaeota 

(Wagner et al. 2004). Hyperthermophiles can be found in both terrestrial and marine thermal 

environments including (but not limited to) hot springs, solfataric fields, and hydrothermal vents, 

with extreme pH, salinity, and atmospheric conditions (Stetter 2006). Although the majority of 

hyperthermophiles belong to the archaeal domain, bacterial hyperthermophiles also exist. More 

than 90 species of hyperthermophilic archaea and bacteria have been identified thus far (van 

Wolferen et al. 2013; Giulio 2003; Setter 2006). Hyperthermophiles represent the most ancient 

forms of life and may be the closest genetic relative to the last common ancestor of all present-

day microorganisms (Fig. 8) (Stetter 2006). 

 

 

Figure 8. Phylogenetic tree of life. Hyperthermophilic lineages shown by thick red lines. (Modified from 

Stetter 2006). 
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The research interest in studying hyperthermophiles is a consequence of their extreme 

physiological adaptations and their potential applications in biotechnology. In particular, their 

unique thermostable enzymes are of key interest (Huber and Stetter 1998; Atomi et al. 2011). 

Hyperthermophilic enzymes function most optimally at extremely high temperatures (above 

70C, with some displaying peak activity at 110C) and are inactive at moderate temperatures 

(below 40C) (Vielle and Ziekus 2001; Unsworth et al. 2007). Being active under conditions of 

extreme pH, high substrate concentrations, and high pressure, the utilization of 

hyperthermophilic enzymes could provide potentially important advantages in industrial 

processes compared to their mesophilic counterparts (i.e., enzymes which are optimally active 

between 25 – 50C) as most industrial processes are performed under harsh conditions (Vielle 

and Ziekus 2001; Sarmiento et al. 2015). 

 

Notwithstanding these advantages, it is difficult to cultivate and obtain pure enzymes from 

hyperthermophiles due to the unique metabolic requirements for growing these organisms 

(Huber et al. 1995; Vielle and Ziekus 2001). Additionally, growing hyperthermophiles on a large 

scale often produces low yields of the desired product (Sarmiento et al. 2015). Thus, for 

technical reasons, hyperthermophilic enzymes are often genetically engineered and expressed in 

mesophilic microbial hosts before they are purified and used to enhance industrial processes. 

Currently, more than 3,000 extremophilic enzymes have been identified for industrial 

applications (Dumorne et al. 2017). Table 1 displays examples of some hyperthermophilic 

enzymes that are industrially produced following genetic introduction to mesophiles.  

 

There are several advantages to performing industrial processes at high temperatures including 

reducing the risk of foreign microbial contamination, improving substrate transfer rates and 

reaction rates, decreasing the viscosity of the medium, and increasing the solubility of substrates 

(Vielle and Ziekus 2001; Unsworth et al. 2007). Studying hyperthermophiles offers the 

possibility of developing an enhanced understanding of thermostable enzyme evolution, their 

unique metabolic pathways, and biochemical reactions, all of which may be used to facilitate a 

variety of biotechnical processes. 
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Table 1. Examples of industrial applications by commercially available enzymes from 

hyperthermophiles. (Adapted from Vielle and Zeikus 2001; de Miguel Bouzas et al. 2006; Ebaid et al. 

2019; Atalah et al. 2019).  

Enzyme Temp 

(C) 

Commercial 

Product 

Manufacturer Application 

Amylase 90 AlphaStar 

PLUS 

Termamyl® 

 

Dyadic 

Novozymes 

Starch 

hydrolysis for 

glucose syrup 

production 

Glucose (xylose) isomerase 90 Sweetzyme®  Novozymes 

 

Genecor 

Conversion of 

glucose to 

fructose 

Glutamate Dehydrogenase Up to 

60 

Glutamate 

Dehydrogenase 

(NAD(P)) (by 

Roche) 

Roche Diagnostic tests 

Laccase 65-70 Denilite® IIS 

(by 

Novozymes) 

Novozymes Textile 

production 

Ligases  

(Pfu from Pyrococcus 

furiosus) 

 

Up to 

85 

Various 

 

 

Stratagene 

 

 

Molecular 

biology 

Lipases  Up to 

90 

Resinanse® 

HT 

Novozymes Kraft pulp 

treatment 

Polymerases 

(Pfu from P. furiosus, Vent 

from Thermococcus 

litoralis, Pwo from P. 

woesei, Deep Vent from 

Pyrococcus strain GB-D, 

DNA from Thermococcus 

sp. strain 9N-7) 

Up to 

80 

Various Various Molecular 

biology 

Protease S 85 – 

90 

Pfu Protease S TaKaRa 

Biomedicals 

Protein 

fragmentation 

for sequencing 

Xylanase Up to 

60 

Xylanase (by 

ProFood) 

ProFood Feed and foods, 

biofuel 

production, 

pharmaceutical 

industry, 

papermaking 
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1.4 Hyperthermus butylicus 

H. butylicus is a hyperthermophilic archaeon that was originally isolated from the seafloor of a 

solfataric (volcanic vents emitting water vapour and sulfuric gas) habitat on the coast of the 

island of São Miguel, Azores, Portugal (Zillig et al. 1990). The Azores are an archipelago 

consisting of nine volcanic islands in the north Atlantic Ocean located more than 1000 km to the 

west of mainland Portugal. This strictly anaerobic microbe has a relatively broad optimal 

temperature range between 95C – 106C and metabolizes peptides as its primary energy and 

nitrogen source (Zillig et al. 1990). When the genome of H. butylicus was sequenced, it was 

found to consist of a single circular chromosome of 1,667,163 bp with 53.7% G-C content 

(Brugger et al. 2007). Moreover, the genome of H. butylicus was found to share many genes that 

code for proteins in other hyperthermophiles such as Aeropyrum pernix and Pyrobaculum 

aerophilum. H. butylicus contains a high percentage of codons that specify charged amino acids. 

This is consistent with the observation that this organism’s proteins contain a lot of charged 

residues on its surface (Brugger et al. 2007). Growth of H. butylicus is strongly stimulated by the 

presence of elemental sulfur (S) and hydrogen gas (H2), with the reduction of sulfur and the 

absence of oxygen resulting in the generation of hydrogen sulfide (H2S). To conserve energy, 

this organism may use a sulfur reducing complex that was identified using genome sequence 

analysis and located in the cell membrane (Brugger et al. 2007). Similar complexes were studied 

from other organisms to reduce elemental sulfur to H2S, however, no experimental data was cited 

in H. butylicus. The protein components associated with the sulfur reducing complex are sulfur 

reductase, hydrogenases, and electron transfer activities bound to the surface of membranes 

which catalyze sulfur reduction to H2S (Brugger et al. 2007). In addition to 1-butanol (67 mmol 

at a 2.2 x 108 cells/mL density), trace amounts of acetic acid, propionic acid, phenylacetic acid, 

hydroxyphenylacetic acid, propylbenzene, acetophenone, and hydroxyacetophenone have been 

found in the spent growth medium of H. butylicus when supplied with tryptone, using gas 

chromatography-mass spectroscopy (Zillig et al. 1990). The presence of these metabolic end-

products is a possible indication of amino acid catabolism (i.e., acetic acid is the product of 

alanine and glycine metabolism, and phenylacetic acid is the product of the metabolism of 

phenylalanine) (Kinoshita et al. 1957; Christensen 1990). Using high performance liquid 

chromatography to assess the organic contents of the spent growth medium, acetone, 

isopropanol, and butyrate were found in addition to 1-butanol (Tse 2016); this is similar to the 
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end-products that has been found in the spent growth medium of Clostridium species. 

Additionally, the gene encoding the enzyme (Hbut_0414) which catalyzes the reaction for 

butanol production in H. butylicus has been found (Tse 2016). Despite this, the solvent 

production pathway for this microorganism is still unknown as well as the optimum conditions 

for its growth and solvent production. 
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1.5 Objectives 

A better understanding of the growth and solvent production of H. butylicus is expected to 

provide valuable insight for future biotechnology research directed toward using 

hyperthermophiles for biofuel production and other potential applications. Past studies (Tse 

2016) have shown that an alcohol dehydrogenase (Hbut_0414) is responsible for the production 

of 1-butanol in H. butylicus, however, the pathway for butanol production in this organism is 

currently unknown. Additionally, using high performance liquid chromatography, H. butylicus 

has been found to produce acetone, ethanol, and isopropanol, in addition to 1-butanol.  Thus, the 

aims of this research are as follows: 

 

1) To optimize and study the growth of H. butylicus under different growth conditions.  

 

2) To confirm and quantify the presence of solvents (acetone, ethanol, isopropanol, and 1-

butanol) using gas chromatography (GC) following the optimal growth of H. butylicus. 

 

3) To determine the effect of organic acid addition (acetate and butyrate) in growth media 

on H. butylicus’ growth and solvent production. 

 

 

 

 

 

 

 



 

  22 

2.0 Materials and Methods 

2.1 Microorganisms, chemicals, and materials 

Hyperthermus butylicus (DSM 5456) was obtained from Deutsche Sammlung von 

Mikroorganismen und Zellkulturen, Germany (DSMZ). All chemicals and laboratory supplies 

such as Eppendorf tubes and disposable syringes used in this study are from commercially 

available sources (Table 2). 

Table 2. Chemicals used in this study.  

Chemical Company 

1-Butanol (GC Grade) Sigma-Aldrich 

(4-(2-hydroxyethyl)-1-piperazineethanesulfonic acid 

(HEPES) 

Bio Basic Inc. 

Acetone (GC Grade) Sigma-Aldrich 

Ammonium chloride (NH4Cl) Sigma-Aldrich 

Ammonium sulfate ((NH4)2SO4) J.T. Baker 

Boric acid (H3BO3) Sigma-Aldrich 

Calcium Chloride, Dihydrate (CaCl2·2H2O) Sigma-Aldrich 

Citric acid (HOC(CH2CO2H)2) J.T. Baker 

Cobalt(II) chloride hexahydrate (CoCl2·6H2O) J.T. Baker 

Cupric(II) sulfate pentahydrate (CuSO4·5H2O) J.T. Baker 

Elemental sulfur Sigma-Aldrich 

Ethanol (GC Grade) Sigma-Aldrich 

Ethyl acetate (GC Grade) Sigma-Aldrich 

Hydrochloric acid (HCl) Fischer Scientific 

Iron(II) sulfate (FeSO4) Sigma-Aldrich 

Isobutanol (GC Grade) Alfa Aesar 

Isopropanol (GC Grade) Sigma-Aldrich 

Magnesium chloride hexahydrate (MgCl2·6H2O) J.T. Baker 

Magnesium sulfate (MgSO4) Fischer Scientific 

Magnesium sulfate heptahydrate (MgSO4·7H2O) EM Science 

Manganese sulfate monohydrate (MnSO4·H2O) J.T. Baker 

Monopotassium phosphate (KH2PO4) B.D.H. Chemicals 

Nickel(II) chloride (NiCl2·6H2O) Sigma-Aldrich 

Nitrilotrioacetic acid (N(CH2CO2H)3) Eastman Chemicals 

Potassium aluminum sulfate dodecahydrate 

(AlK(SO4)2·12H2O) 

B.T. Baker 

Potassium chloride (KCl) B.D.H. Chemicals 

Potassium iodide (KI) Sigma-Aldrich 

Resazurin Sigma-Aldrich 

Sodium acetate (NaCH₃COO) Fischer Scientific 

Sodium bromide (NaBr) Fischer Scientific 

Sodium butyrate (Na(C3H7COO)) Sigma-Aldrich 

Sodium chloride (NaCl) Bio Basic Inc. 

Sodium hydroxide (NaOH) Fischer Scientific 
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Sodium molybdate dihydrate (Na2MoO4·2H2O) Fischer Scientific 

Strontium chloride hexahydrate (SrCl2·6H2O) Sigma-Aldrich 

Tryptone Bio Basic Inc. 

Zinc sulfate heptahydrate (ZnSO4·7H2O) B.D.H. Chemicals 
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2.2 Anaerobic techniques 

 

A manifold (Fig. 9) system allows for the alternate transfer of vacuum and gas (either N2 or H2) 

following a method developed previously (Tse 2016). Using aseptic techniques, sterile 25G 

needles were attached to the manifold by which a sealed container (such as a serum bottle with a 

rubber stopper) can be made anaerobic. Sterile 25G needles punctured through the stoppers allow 

for the exchange of gases within the sealed container. The gases are deoxygenated when they 

pass through a heated catalyst. Sealed bottles were degassed for 40 min followed by 3 cycles of 

gassing (with N2)/degassing (by vacuum) for 3 min each. In the gas position (at ~2 psi N2) a 

second needle (25G) was used to puncture the stopper and ethanol was added to the needle to 

show some bubbling, indicating the flushing out of the N2 ensuring that the bottles have an 

oxygen-free headspace (bottles are flushed for 2 min). Lastly, needles were removed and 

pressurized with N2 to have a positive pressure headspace (0.14 atm over-pressurized). 

 

Syringes were made anaerobic by rinsing with degassed sterilized water or an anaerobic buffer. 

To ensure microbubbles of air in the syringe are completely removed/absorbed, ~1 mL of 

anaerobic buffer was drawn into the syringe, then left aside for ~5 min; the same was done with 

the desired solution (~1 mL of solution, left for ~5 min).  

 

 

Figure 9. Manifold system used to create anaerobic environments in sealed serum bottles.  
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The use of H2 was required to be performed in the fume hood where another manifold is installed 

for safety. The procedure is principally the same as described above for the use of N2. However, 

for adding pressurized H2 (> ~0.2 atm, but up to 3 atm over-pressure) to a sealed container, there 

was no use of any manifold. A red vacuum rubber tubing (Inner diameter: 1/4”, Outer diameter: 

5/8”) connected to a sterile syringe, a sterile syringe filter, and a 25G needle attached to the 

regulator on the H2 tank was used to add H2 directly to a desired (sealed) container such as a 

serum bottle in a fume hood. The H2 tank was slowly opened to 44 psi, and gas was allowed to 

flow for ~10 seconds to remove any oxygen from the tubing. The needle was used to puncture 

the rubber stopper on the bottle and gas was allowed to flow into the bottle for ~20 seconds. 

After ~20 seconds, the needle was removed from the bottle (a visible bump in the stopper will 

appear indicating the presence of added H2). The bottle was held tightly during the entire 

procedure for safety.   
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2.3 Growth of H. butylicus  

H. butylicus was grown in medium supplemented with trace minerals and vitamin solutions, 

described previously by DSMZ and modified by Tse (2016). H. butylicus was routinely cultured 

anaerobically at 95°C in 60 mL glass serum bottles.  

 

The medium composition is based on Medium 491 provided by DSMZ (Deutsche Sammlung 

von Mikroorganismen und Zellkulturen, Germany), with modifications. All chemicals were 

added sequentially in the order listed and mixed on a stir plate until completely dissolved with 

the exception of elemental sulfur and sodium sulfide, which were added separately from the rest 

of the components (Table 3). Trace mineral solution (Table 4) is from DSMZ (Medium 141), 

with modifications (Balch et al. 1979). The medium pH was adjusted to 6.6 and was stored in 

4°C until needed. 
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Table 3. Composition of H. butylicus medium. 

Chemical g/L 

NaCl 17.0 

MgSO4·7H2O 3.5 

MgCl2·6H2O 2.75 

KCl 0.325 

NaBr 0.05 

H3BO3 0.0015 

SrCl2·6H2O 0.0075 

Citric acid 0.005 

KI 0.0025 

CaCl2·2H2O 0.2 

KH2PO4 0.5 

NiCl2·6H2O 0.002 

(NH4)2SO4 0.01 

Elemental sulfur (from Sigma-Aldrich) 10.0 

NH4Cl 0.5 

Tryptone 6.0 

100x Trace minerals 10.0 mL (Table 3) 

Resazurin 1.0 

(4-(2-hydroxyethyl)-1-piperazineethanesulfonic 

acid (HEPES) 

5.2 

Na2S·9H2O (3% w/v)  10.0 mL 

Deionized Water (DI H2O) Fill to 1.0 L 

 

 

Table 4. Composition of trace mineral solution used for the growth of H. butylicus. 

Chemical g/L 

Nitrilotrioacetic acid 1.500 

MgSO4 1.460 

MnSO4·H2O 0.450 

NaCl 1.000 

FeSO4  0.055 

CoCl2·6H2O 0.200 

CaCl2·2H2O 0.100 

ZnSO4·7H2O 0.180 

CuSO4·5H2O 0.010 

AlK(SO4)2·12H2O 0.018 

H3BO3 0.010 

Na2MoO4·2H2O 0.010 

Deionized Water (DI H2O) Fill to 1L 
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The volume of medium (from the prepared stock) needed for culturing varies depending on the 

number and size of the culture bottles used. The standard medium volume for a 60 mL serum 

bottle is 20 mL of H. butylicus medium. Elemental sulfur of 0.2 g was added to autoclaved 60 

mL serum bottles (6 g/L), then pH-adjusted medium was added to the bottles (20 mL of medium 

each). After the medium was dispensed, the bottles were capped with grey butyl stoppers and 

aluminum seals, and a hand crimper was used to attach seals to bottles. The prepared bottles 

were then placed in a sonicator (VWR) filled 1/2 of the way with DI water for 3 min to dissolve 

the sulfur in the bottles. Under aseptic conditions, culture bottles were made anaerobic using a 

manifold (see: Section 2.2). Once anaerobic, bottles were placed in a water bath heated to 90°C 

and sterilized for 1 hour and then removed from the water bath. Bottles containing the medium 

were sterilized at 90°C for 1 hour each day, for a total of 3 days. Following the third day of 

sterilization, the medium was reduced with 0.2 mL of Na2S (3% w/v) using a sterile anaerobic 1 

mL syringe equipped with a sterile 25G needle (see: Section 2.2). Bottles were then placed in a 

heated 95°C water bath, and incubated for 15 min. The bottles were ready for inoculation once 

they were cooled to room temperature. The gas phase in the bottles was exchanged from N2 to H2 

at ~2 psi (see: Section 2.2), then 10% of the total medium volume (v/v) of fresh late-log phase 

culture (cell density > 1.0 x 108 cells/mL) was inoculated into each bottle, using an anaerobic 

syringe. Three atm of H2 (over-pressurized) was added directly to each bottle (see: Section 2.2), 

then the bottles were incubated in a 95°C water bath, with growth monitored via direct 

microscopic cell counts (see: Section 2.3.1). 

2.3.1 Monitoring growth of H. butylicus 

Growth (cell density in cells/mL) of H. butylicus was monitored using a Nikon Eclipse E600 

phase-contrast light microscope and a Petroff-Hausser counting chamber (1/400 mm2, 0.02 mm 

deep). Growth curves were plotted on a semi-logarithmic scale for cell density (cells/mL) against 

time (hours). 

2.3.2 Optimization of growth 

H. butylicus cells were grown using elemental sulfur from different manufacturers (Fisher 

Scientific, VWR, Sigma-Aldrich) to determine which provided the maximum cell growth 

(cells/mL). The amount of sulfur was the same for all cultures (6 g/L) and growth was observed 

over 50 hours for each type of elemental sulfur.  
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Varying pH growth conditions (pH 6.0, 6.5, 7.0, and 8.0), H2 pressures (0, 1, 2.5, 3 atm over-

pressurized), and sulfur concentrations (0, 1, 5, 6, and 10 g/L), all in duplicates, were tested for 

cell growth (cells/mL) throughout each growth phase. The growth medium pH was adjusted to 

the desired pH prior to sterilization and pH was periodically checked using a pH meter with a pH 

electrode (Cole-Parmer) and pH paper (J.T. Baker).  

2.3.3 Addition of organic acids 

A 1 M stock solution of sodium acetate (MW: 82.03 g/mol) and sodium butyrate (MW: 110.1 

g/mol) was prepared fresh each time (2 mL each). For 1 M sodium acetate stock, 0.16 g was 

weighed out then dissolved in 2 mL of deionized water. For 1 M sodium butyrate stock, 0.22 g 

was weighed out then dissolved in 2 mL of deionized water. Sodium acetate and sodium butyrate 

were added to 20 mL of H. butylicus media after all other components were added and dissolved 

but before the pH of the medium was adjusted (see: Section 2.2). The final concentrations of 

sodium acetate and sodium butyrate were 5 mM and 15 mM, respectively. For a final 

concentration of 5 mM, 0.1 mL of sodium acetate was added to 20 mL of H. butylicus medium; 

the same was done for 5 mM of sodium butyrate. For 15 mM, 0.3 mL of sodium acetate was 

added to 20 mL of H. butylicus medium; the same was done for 5 mM of sodium butyrate. The 

pH of the entire mixture was adjusted to pH 6.6, then dispensed into culture bottles. The 

remaining procedure was followed for preparing culture bottles for growth (see: Section 2.2). 
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2.4 Instruments and equipment 

All instruments and equipment used in this study are commercially available (with the exception 

of the manifold system) (Table 5). 

 

Table 5. Instruments, equipment, and major laboratory supplies used in this study. 

Instruments and equipment Company (Country) 

Aluminum seal (20 mm CS/M) Fisher Scientific (Canada) 

Balance: 

Analytical (Fisher Scientific Accu-64) 

Top-loading (Acculab AL-1502) 

 

Fisher Scientific (Canada) 

Acculab (USA) 

Butyl grey stopper (20 mm) Fisher Scientific (Canada) 

Centrifuge (Heraeus Biofuge Pico) Thermo Fisher Scientific (Canada) 

Eppendorf tubes (1.5 mL) Fisher Scientific (Canada) 

Gas chromatography (Model 910) Buck Scientific (USA) 

Gas chromatography (Shimadzu GC-14a) Shimadzu (Japan) 

Gas chromatography vial (2 mL 9 mm Amber 

glass and screw top cap with PTFE septum) 

Thermo Fisher Scientific (Canada) 

Glass syringe (10 μL) Thermo Fisher Scientific (Canada) 

Gas tanks (Air, Helium, Hydrogen, and Nitrogen) Praxair (Canada) 

Hand Crimper Wheaton (USA) 

Manifold system Made by Ma’s lab at University of Waterloo 

(Canada) 

Microscope (Nikon Eclipse E600 phase-contrast 

light microscope) 

Nikon (Japan) 

Needles (25 G) Thermo Fisher Scientific (Canada) 

Rotary shaker New Brunswick Scientific (Canada) 

Petroff-Hauser counting chamber (1/400 mm2, 

0.02 mm deep) 

Hausser Scientific (USA) 

pH electrode Cole Parmer (Canada) 

pH meter (accumet Basic, AB15) Fisher Scientific (Canada) 

 

pH paper (BAKER-pHIX' pH Papers with Color 

Scale) 

J.T. Baker (USA) 

Serum bottles (60 mL glass bottle) Wheaton (USA) 

Sonicator (Ultrasonic cleaner, 50-D) VWR (Canada) 

Stir plate (Corning PC-610) Corning (USA) 

Syringe (1 mL – Slip Tip) VWR (USA) 

Syringe filter (0.45 μm) Sarstedt (USA) 

Vortex mixer Fisher Scientific (Canada) 

Waterbath (ISO Temp 215) Fisher Scientific (Canada) 
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2.5 Detection of metabolic end-products 

2.5.1 Determination of solvents using gas chromatography (GC) 

A Shimadzu GC-14a equipped with an FID detector and a combined column, a DB-5 (Agilent 

J&W DB-5 GC Column, 30 m, 0.32 mm, 0.25 µm, 7-inch cage) and DB-624 (Agilent J&W DB-

624 GC Column, 30 m, 0.32 mm, 1.80 µm, 7-inch cage), was used for the detection of solvents. 

GC conditions used were as follows: injector temperature: 250°C; flame ionizer detector (FID) 

temperature: 250°C; FID sensitivity range: 101 for 11.6 min, 102 for 8.4 min, 101 for 10 min; 

carrier gas: helium (pressure: 1 kg/cm2); H2 (pressure: 1 kg/cm2); Air (pressure: 0.4 kg/cm2). The 

temperature program used was as follows: initial isotherm at 35°C held for 10 mins; ramp rate: 

1°C/min to 40°C held for 2 mins, 45°C/min to 150°C; final isotherm: 150°C held for 1 min; 

Range: 1 for the first 11.6 mins, 2 for 8.4 min (to 20 min), 1 for the remainder for the run (10 

min). One L of sample was injected into the GC for analyses.   

 

GC data was recorded using PeakSimple software (version 4.51, SRI Instruments). To allow for 

the electronic recording of GC samples the Shimadzu GC-14a was connected to a secondary GC 

(GC Buck) using electrical wiring, as the PeakSimple program is installed on a computer that is 

connected to the GC Buck. A low constant flow of N2 (pressure: 20 psi) is required to be running 

while the GC Buck is on to avoid damaging the column. Both the GC Buck and Shimadzu GC-

14a need to be on for PeakSimple to record the data.  

 

Standard curves for acetone, ethanol, isopropanol, and 1-butanol were prepared at concentrations 

of 0.25, 0.5, 1, 3, and 5 mM, as well as mixed solvent standards (composed of acetone, ethanol, 

isopropanol, and 1-butanol) at the same concentrations. H. butylicus cultures supplemented with 

5- and 15-mM of sodium butyrate and sodium acetate were analyzed for solvent production 3 

atm H2 (over-pressurized) and compared against solvent production under the absence of 

butyrate and/or acetate. A control containing uninoculated H. butylicus media was run in 

duplicate at each time point acting as a control. Sample preparation for culture samples and 

standard solutions were prepared as described in Section 2.3.2.  
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2.5.2 Preparation of GC samples 

The extraction solution (composed of ethyl acetate and 2 g/L of isobutanol) was vortexed for 3 

seconds, then 200 µl of this solution was immediately dispensed into new 1.5 mL eppendorf 

polyethylene tubes. In the same tube, 1 mL of sample/standard was dispensed, and the cap was 

closed immediately. Tube(s) were vortexed for 3 seconds then put onto a shaker (New 

Brunswick Scientific Gyrotory G76 shaker) for 15 min at 200 rpm. Tube(s) were then 

centrifuged (Heraeus Biofuge Pico) for 2 min at 952 x g (10,000 rpm). Once the sample(s) were 

centrifuged, the supernatant (~180 µL) was obtained and dispensed into a clean 2 mL GC vial 

with a screw top cap and PTFE septum (Thermo Fisher Scientific) (Fig. 10).  

 

 

Figure 10. Schematic diagram of a GC sample. The top (“blue”) layer represents the solvent layer that 

is obtained and run on the GC; the bottom layer (the supernatant) represents the debris/other components 

of H. butylicus medium that will be discarded.  
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2.6 Integration of gas chromatography peak areas 

2.6.1 Automatic integration by PeakSimple software 

PeakSimple automatically integrates detected peaks however, as the solvent peaks in H. butylicus 

samples do not have a typical Gaussian shape, the default baseline does not include the entire 

area of the peak. As can be seen in Fig. 11(a), the automatic integration created a baseline that 

follows the shape of the peaks rather than underneath the peak, as in Fig. 11(b). This means that 

only a portion of the peak is integrated when using the automatic integration. To ensure the 

entire area of the peak is included when integrating standards and samples, a manual integration 

is required.  

 

(a) 

 

(b) 

 

Figure 11. Chromatograph from PeakSimple (version 4.51) displaying the difference between (a) 

automatic integration and (b) manual integration. Blue lines indicate area of peak detected by the 

software. 
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2.6.2 Manual Integration 

Using PeakSimple software (see: Section: 2.5.1) for recording and integration of GC 

chromatographic peaks, a combination of height (mV) and area is utilized to determine 

concentration (mM) of standards and H. butylicus samples. When determining the height of the 

peak, the cursor is simply placed on top of the peak and a value in the right-hand corner of the 

software will indicate the height (mV); the value to the left of the height is the corresponding 

time point (Fig. 12). 

 

 

Figure 12. Chromatograph from PeakSimple (version 4.51) displaying height (mV) and time (min). 

The height (mV) of a given peak is shown in the upper right-hand corner of the chromatograph; this is 

indicated by the red arrow. The corresponding time point is indicated by the blue arrow.  

 

As briefly mentioned in Section 2.6.1, the solvent peaks in H. butyicus samples do not have a 

typical Gaussian shape and sample peaks often do not sit flush on the baseline. To account for 

this, a manual baseline must be created to include the entire area under a peak (Appendix C: 

PeakSimple Operation Procedure). 

 

2.6.3 PeakSimple Software parameters 

For integration of a GC peak area the area reject value is set to 0.001 to allow for the detection of 

smaller peaks (Appendix C: PeakSimple Operation Procedure).  
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2.6.4 Operation of PeakSimple with Shimadzu GC-14a 

The voltage of the baseline (mV) must be equalized when the GC Buck is turned on (Appendix 

C: PeakSimple Operation Procedure). As mentioned in Section 2.5.1, the PeakSimple 

recording software is installed on a computer which is connected to the GC Buck. This means 

that when running a sample, PeakSimple will not automatically begin recording with the 

injection of a sample on the Shimadzu GC-14a, so the user must manually perform this step.  
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3.0 Results 

3.1 Growth of H. butylicus 

3.1.1 Optimization of growth conditions 

H. butylicus was grown in 60 mL bottles at 95C. Its growth was monitored by cell counts 

measured in duplicate using a Petroff Hauser counting chamber and a contrast phase microscope. 

Optimal growth conditions of H. butylicus are required to obtain maximum fermentation 

products. For the optimization of pH, H. butylicus was grown using the media described in 

Section 2.3 to determine the effect of pH on growth; the pH of the medium was adjusted to 6.0, 

6.5, 7.0, and 8.0 with no other changes to the medium. pH was measured at room temperature 

before and after inoculation as well as throughout growth; measurements were conducted in 

duplicate using pH paper (Millipore, CA) that was also calibrated using a pH meter. Minimal 

difference was seen in H. butylicus grown in mediums with varying pHs however, the highest 

growth was observed at pH 7.0 (2.14 x 108 cells/mL) and the least favourable growth at pH 6.0 

(9.13 x 107 cells/mL). Growth was progressively more favourable for 6.5 and 8.0 (Fig. 13). 

 

 

Figure 13. Growth of H. butylicus at varying pHs. Cell counts were from two biological replicates, 

each an average of duplicate counts. Error bars shown as ± standard deviation.  
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Growth of H. butylicus is stimulated by the presence of H2. To determine the magnitude of the 

effect, pressures of H2 ranging from 3 psi, 1.0, 2.5, to 3.0 atm (over-pressurized) in culture 

bottles were tested. For the optimization of H2, H. butylicus was grown using the medium 

described in Section 2.3. Cultures grown in 3 psi H2 (or 0 atm over-pressurized) resulted in a 

lower cell density and longer log phase while only a minimal difference was observed for 

cultures grown in 2.5 and 3.0 atm H2 (Fig. 14). 

 

 

Figure 14. Growth of H. butylicus under varying pressures of H2. Cell counts are from two biological 

replicates, each an average of duplicate counts. Error bars shown as ± standard deviation. 
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In addition to H2, growth of H. butylicus is also stimulated by the presence of sulfur. To 

determine how effectively H. butylicus can utilize varying concentration of sulfur, the medium 

was prepared in the presence of sulfur ranging from 0, 1.0, 5.0, to 10.0 g/L. The pH of the 

medium was kept constant at 7.0 and H2 at 3.0 atm (over-pressurized) for each test. When 

comparing the different concentrations of sulfur, higher concentrations positively correlated with 

higher growth. A concentration of 10.0 g/L resulted in the highest growth while cultures grown 

without any sulfur displayed approximately half of the maximum cell density (1.17 x 108 

cells/mL) (Fig. 15).  

 

 

Figure 15. Growth of H. butylicus under varying sulfur concentrations. Cells were grown under the 

same medium composition and 3.0 atm of H2 (over-pressurized). Cell counts are from two biological 

replicates, each an average of duplicate counts. Error bars shown as ± standard deviation. 
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Following optimization, the following growth conditions were obtained: pH 7.0, 3.0 atm H2 

(over-pressurized), and 10.0 g/L of sulfur at 95°C. Growth under these optimal conditions was 

successfully achieved in the laboratory for cultures of H. butylicus grown in 20 mL of medium in 

60 mL glass serum bottles. A final cell density of above 1.0 x 108 cells/mL was achieved (Fig. 

16).  

 

 

Figure 16. H. butylicus growth under optimal conditions. Cells were grown under the same 

composition of medium (10.0 g/L of sulfur), pH of 7.0, and 3.0 atm of H2 (over-pressurized). Cell counts 

are from two biological replicates, each an average of duplicate counts. Error bars shown as ± standard 

deviation. 
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3.1.2 Growth of H. butylicus in acetate and butyrate supplemented media 

The cell growth response of H. butylicus in the presence and absence of supplemented sodium 

butyrate and sodium acetate was tested. The cell culture in the medium containing supplemented 

butyrate showed no significant difference compared to the cell culture grown in un-supplemented 

medium. Both butyrate supplemented and un-supplemented cultures grew to a similar final 

maximum cell density of > 1.0 x 108 cells/mL (Fig. 17). Cell cultures grown in medium 

supplemented with acetate grew slower with an extended log phase followed by a lower final cell 

density < 1.0 x 108 cells/mL. Cultures with the addition of 15 mM acetate in the growth medium 

had the lowest growth (5.9 x 107 cells/mL) (Fig. 18).  

 

 

Figure 17. Growth of H. butylicus in butyrate supplemented media. Cells were grown under the same 

composition of medium (10.0 g/L of sulfur), pH of 7.0, and 3.0 atm of H2 (over-pressurized). Cell counts 

are from two biological replicates, each an average of duplicate counts. Error bars shown as ± standard 

deviation. 
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Figure 18. Growth of H. butylicus in acetate supplemented media. Cells were grown under the same 

composition of medium (10.0 g/L of sulfur), pH of 7.0, and 3.0 atm of H2 (over-pressurized). Cell counts 

are from two biological replicates, each an average of duplicate counts. Error bars shown as ± standard 

deviation. 
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3.2 Solvent detection 

3.2.1 Optimization of liquid-liquid extraction procedure 

When preparing samples for analysis using GC, an internal standard is commonly used to aid in 

quantifying unknown samples. The internal standard was 2.0 g/L of isobutanol in ethyl acetate, 

which was used as the extraction solution in a liquid-liquid extraction method to separate the 

desired solvents from other impurities in H. butylicus medium. To determine the sample volume 

and corresponding extraction solution (or internal standard) volume, varying ratios of 5 mM 

mixed (ethanol, acetone, isopropanol, and 1-butanol) standard to extraction solution was tested. 

A lower volume and equal ratio of 200 μL:200 μL (sample:extraction solution) resulted in more 

interfering peaks compared to 200 μL:600 μL. One mL to 200 μL of sample to extraction 

solution resulted in the best resolution and highest peak areas. Shaking times for prepared GC 

samples were also optimized. Fifteen minutes of shaking provided the best separation of solvents 

and the maximum area of solvents when analyzed on the GC (data not shown).  

3.2.2 Optimization of the GC method 

Optimizing the GC method was a crucial step in detecting and quantifying the fermentation 

products of H. butylicus. All parameters were constantly considered when selecting the most 

optimal conditions for the GC run including the column that was used, injection and detector 

temperatures (C), initial temperature (C) and holding time (min), flow rate of carrier gas, ramp 

rate (C/min), and final temperature (C). The Shimadzu GC-14a equipped with a DB-5 and DB-

624 combined column was ultimately used for detecting solvents from H. butylicus. Although 

acetone, ethanol, and isopropanol peaks could not be separated completely, a series of 

optimizations led to the final method (Table 6) which provided the best resolution and separation 

of peaks with the columns that were used: Injection temp.: 200C, Detector temp.: 300C, Initial 

temp.: 35C (hold for 10 min), Program rate: 3C/min to 40C, 45C/min to 150C, Final temp.: 

150C (hold for 1 min), Range: 1 (for 10 min), 2 (for remainder of run).  
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Table 6. Optimization of GC method (Shimadzu GC-14a equipped with DB-5 and DB-624 

combined GC column). 

Test Column Method Difference Outcome 

1 

 

DB-5 (Cat 

No.: 123-

5032) 

 

Injection temp.: 200C 

Detector temp.: 300C 

Initial temp.: 35C 

Program rate: 1C/min to 45C, 

40C/min to 150C  

Final temp.: 150C (hold for 1 

min) 

Range: 4 

None. Column damaged from 

conditioning. 

2 DB-624 UI 

(Cat No.: 

123-1334) 

 

Injection temp.: 200C 

Detector temp.: 300C 

Initial temp.: 35C 

Program rate: 1C/min to 45C, 

40C/min to 150C  

Final temp.: 150C (hold for 1 

min) 

Range: 4 

Column changed. 1-Butanol not detected. 

3 DB-624 UI 

(Cat No.: 

123-1334) 

 

Injection temp.: 200C 

Detector temp.: 240C 

Initial temp.: 80C 

Program rate: 10C/min to 90C 

(hold for 1 min), 30C/min to 

150C 

Final temp.: 150C (hold for 1 

min) 

Range: 4 

New method 

according to 

parameters 

recommended by 

Agilent for new 

column. 

No peaks detected. 

4 DB-624 

(Cat No.: 

123-134) 

 

Injection temp.: 250C 

Detector temp.: 300C 

Initial temp.: 40C (hold for 5 

min) 

Program rate: 2C/min to 90C, 

40C/min to 180C  

Final temp.: 180C (hold for 1 

min) 

Range: 4 

Column changed. 

 

New method 

according to 

parameters 

recommended by 

Restek. 

No peak detected. 

5 DB-624 

(Cat No.: 

123-134) 

 

Injection temp.: 250C 

Detector temp.: 300C 

Initial temp.: 40C (hold for 5 

min) 

Program rate: 10C/min to 

240C 

Final temp.: 240C (hold for 3 

min) 

Range: 4 

Program rate and 

final temperature 

changed. 

Too much peak 

splitting. 

 

 

 

 

 

 

  



 

  44 

6 DB-624 

(Cat No.: 

123-134) 

 

Injection temp.: 250C 

Detector temp.: 300C 

Initial temp.: 35C (hold for 5 

min) 

Program rate: 10C/min to 

100C, 15C to 220C, 25C to 

240C 

Final temp.: 240C (hold for 1 

min) 

Range: 4 

Initial time and 

program rate 

changed. 

Too much peak splitting 

(too many individual 

peaks) 

7 DB-624 

(Cat No.: 

123-134) 

 

Injection temp.: 200C 

Detector temp.: 300C 

Initial temp.: 35C 

Program rate: 1C/min to 45C, 

40C/min to 150C  

Final temp.: 150C (hold for 1 

min) 

Range: 4 

Initial hold time, 

program rate, and 

final temperature 

changed. 

Insufficient separation 

of peaks 

8 DB-624 

(Cat No.: 

123-134) 

 

Injection temp.: 200C 

Detector temp.: 300C 

Initial temp.: 35C 

Program rate: 2C/min to 45C, 

40C/min to 150C  

Final temp.: 150C (hold for 1 

min) 

Range: 4 

Program rate 

changed. 

Insufficient separation 

of peaks 

9 DB-624 

(Cat No.: 

123-134) 

 

Injection temp.: 200C 

Detector temp.: 300C 

Initial temp.: 35C 

Program rate: 1.5C/min to 

45C, 40C/min to 150C  

Final temp.: 150C (hold for 1 

min) 

Range: 4 

Program rate 

changed. 

Insufficient separation 

of peaks 

10 DB-624 

(Cat No.: 

123-134) 

 

Injection temp.: 200C 

Detector temp.: 300C 

Initial temp.: 35C 

Program rate: 1.7C/min to 

45C, 40C/min to 150 degrees 

C  

Final temp.: 150C (hold for 1 

min) 

Range: 4 

Program rate 

changed. 

Acetone, ethanol, and 

isopropanol peaks are 

too small  
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11 DB-624 

(Cat No.: 

123-134) 

 

Injection temp.: 200C 

Detector temp.: 300C 

Initial temp.: 35C 

Program rate: 1.7C/min to 

45C, 40C/min to 150 degrees 

C  

Final temp.: 150C (hold for 1 

min) 

Range: 2 

Range changed. Poor separation of ethyl 

acetate, isobutanol, and 

1-butanol.  

 

Poor separation of 

acetone, ethanol, and 

isopropanol. 

12 DB-624 

(Cat No.: 

123-134) 

 

Injection temp.: 200C 

Detector temp.: 300C 

Initial temp.: 35C (hold for 5 

min) 

Program rate: 1.7C/min to 

45C, 40C/min to 150C  

Final temp.: 150C (hold for 1 

min) 

Range: 2 

Initial 

temperature hold 

time changed. 

Better separation of 

acetone, ethanol, and 

isopropanol from ethyl 

acetate, isobutanol, and 

1-butanol.  

 

Poor separation within 

acetone, ethanol, and 

isopropanol. 

13 Rt-U-

BOND (Cat 

No.: 

19772) 

 

 

Injection temp.: 200C 

Detector temp.: 300C 

Initial temp.: 35C (hold for 10 

min) 

Program rate: 30C/min to 

175C  

Final temp.: 175C  

Range: 4 

 

Column changed.  

 

New method 

according to 

parameters 

recommended by 

Restek for new 

column. 

Column changed due to 

poor separation of 

acetone, ethanol, and 

isopropanol.  

 

Method changed 

according to 

recommended 

parameters from Restek. 

 

No peaks detected. 

14 DB-5 (Cat 

No.: 123-

5032) 

+ DB-624 

(Cat No.: 

123-134) 

Combined 

Injection temp.: 200C 

Detector temp.: 300C 

Initial temp.: 35C (hold for 5 

min) 

Program rate: 3C/min to 45C, 

40C/min to 150C  

Final temp.: 150C (hold for 1 

min) 

Range: 2 

Two columns 

combined. 

 

Only program rate 

changed from the 

previous method 

(12). 

Better separation of 

acetone, ethanol, and 

isopropanol from ethyl 

acetate, isobutanol, and 

1-butanol.  

 

Poor separation within 

acetone, ethanol, and 

isopropanol.  

 

Better resolution of 

acetone, ethanol, and 

isopropanol.  
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15 DB-5 (Cat 

No.: 123-

5032) 

+ DB-624 

(Cat No.: 

123-134) 

Combined 

Injection temp.: 200C 

Detector temp.: 300C 

Initial temp.: 35C (hold for 10 

min) 

Program rate: 3C/min to 45C, 

40C/min to 150C  

Final temp.: 150C (hold for 1 

min) 

Range: 2 

Initial 

temperature hold 

time changed. 

Good separation of 

acetone, ethanol, and 

isopropanol from ethyl 

acetate, isobutanol, and 

1-butanol. 

 

Poor separation within 

acetone, ethanol, and 

isopropanol. 

 

Better resolution of 

acetone, ethanol, and 

isopropanol. 

16 DB-5 (Cat 

No.: 123-

5032) 

+ DB-624 

(Cat No.: 

123-134) 

Combined 

Injection temp.: 200C 

Detector temp.: 300C 

Initial temp.: 35C (hold for 10 

min) 

Program rate: 3C/min to 45C, 

40C/min to 150C  

Final temp.: 150C (hold for 1 

min) 

Range: 2 

Column changed 

back to combined 

column.  

 

Previous method 

used (14). 

Good separation of 

acetone, ethanol, and 

isopropanol from ethyl 

acetate and isobutanol. 

 

Poor separation within 

acetone, ethanol, and 

isopropanol. 

 

1-Butanol not detected. 

17 DB-5 (Cat 

No.: 123-

5032) 

+ DB-624 

(Cat No.: 

123-134) 

Combined 

Injection temp.: 200C 

Detector temp.: 300C 

Initial temp.: 35C (hold for 10 

min) 

Program rate: 3C/min to 60C 

(hold for 2 min), 40C/min to 

150C  

Final temp.: 150C (hold for 1 

min) 

Range: 2 

Program rate 

changed. 

Isobutanol peak blended 

with impurity.  

18 DB-5 (Cat 

No.: 123-

5032) 

+ DB-624 

(Cat No.: 

123-134) 

Combined 

Injection temp.: 200C 

Detector temp.: 300C 

Initial temp.: 35C (hold for 10 

min) 

Program rate: 3C/min to 60C, 

40C/min to 150C  

Final temp.: 150C (hold for 1 

min) 

Range: 2 

Program rate 

changed. 

Isobutanol peak tails 

into 1-butanol. 

 

Good separation of 

acetone, ethanol, and 

isopropanol from ethyl 

acetate, isobutanol, and 

1-butanol. 

 

Poor separation within 

acetone, ethanol, and 

isopropanol. 

 

Acetone, ethanol, and 

isopropanol are difficult 

to see at low 

concentrations (peaks 
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too small compared to 

other solvents). 

 

 

19 DB-5 (Cat 

No.: 123-

5032) 

+ DB-624 

(Cat No.: 

123-134) 

Combined 

Injection temp.: 200C 

Detector temp.: 300C 

Initial temp.: 35C (hold for 10 

min) 

Program rate: 3C/min to 60C, 

40C/min to 150C  

Final temp.: 150C (hold for 1 

min) 

Range: 1 (for 10 min), 2 (for 

remainder of run) 

Range changed. Isobutanol peak tails 

into 1-butanol. 

 

Acetone, ethanol, and 

isopropanol can be seen 

at low concentrations.  

 

 

20 DB-5 (Cat 

No.: 123-

5032) 

+ DB-624 

(Cat No.: 

123-134) 

Combined 

Injection temp.: 200C 

Detector temp.: 300C 

Initial temp.: 35C (hold for 10 

min) 

Program rate: 3C/min to 40C, 

45C/min to 150C  

Final temp.: 150C (hold for 1 

min) 

Range: 1 (for 11.6 min), 2 (for 

8.4 min – to 20 min), 1 (for 

remainder of run) 

 

 

Program rate 

changed. 

 

Range hold time 

changed. 

Isobutanol no longer 

tails into 1-butanol.  

 

Acetone, ethanol, and 

isopropanol peaks still 

have poor separation but 

can be identified 

distinguishably. 

 

No issues with ethyl 

acetate, isobutanol, or 1-

butanol. 

 

Final method (20) 

provided the best 

separation for all 

solvents.  
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3.2.3 Standard curves 

Standard concentrations of 0, 0.25, 0.5, 1, 3, and 5 mM were separately prepared for 1-butanol, 

acetone, ethanol, and isopropanol. One mL standard samples were mixed with 200 uL of 

extraction solution (2 g/L isobutanol in ethyl acetate) and run on the GC. Using isobutanol as the 

internal standard, a peak ratio was obtained with the peak area of the known standard solvent and 

corresponding peak area of isobutanol. From the extraction solution there exists two impurity 

peaks that interfere with the peak areas of the target solvents (Fig. 19).  

 

 

Figure 19. GC chromatograph of a control sample (0 mM) recorded using PeakSimple software 

(version 4.51). Control sample contains H. butylicus uninoculated media. Blue arrow indicates 

interference with peaks of acetone, ethanol, and isopropanol (6.25 – 6.40 min). Red arrow indicates 

interference with 1-butanol (20.75 – 21.85 min).  

 

Each individual standard sample of 1-butanol, ethanol, acetone, and isopropanol showed a 

characteristic peak allowing it to be identifiable (Fig. 20, Fig. 21). Only 1-butanol was separated 

completely while the peaks of ethanol, acetone, and isopropanol were overlapping and could not 

be separated entirely. However, as mentioned, there were signature (or uniquely characteristic) 

peaks for ethanol, acetone, and isopropanol, respectively (Fig. 21, Table 7).   
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Figure 20. GC chromatograph of a 3 mM 1-butanol standard sample recorded using PeakSimple 

software (version 4.51). Retention time of peak is 20.75 – 21.85 min. 

 

 

Figure 21. GC chromatograph of a 3 mM mixed standard sample recorded using PeakSimple 

software (version 4.51). Black – 3 mM mixed (acetone + ethanol + isopropanol), red – 3 mM acetone, 

green – 3 mM ethanol, purple – 3 mM isopropanol. Green arrow – 3 mM ethanol unique peak, red arrow 

– 3 mM acetone unique peak, purple arrow – 3 mM isopropanol unique peak. 

 

 

 

 

 

 

 

 

 

 

 



 

  50 

Table 7. Identification and calculation of solvents using unique peaks. 

Product Unique Peak 

Retention Time (min) 

How to determine 

presence of product 

How to calculate 

concentration (mM) 

of product 

1-Butanol 20.75 – 21.85 Overlap with a small 

extraction solution 

interference. If peak 

area is higher than the 

extraction solution 

interference (area > 3), 

it is considered to be 1-

butanol. 

Use PeakSimple 

software to integrate 

the area of 1-butanol 

peak. Use the standard 

curve and peak area to 

calculate concentration. 

Ethanol 5.75 – 6.25 Overlap by a small 

extraction solution 

interference. Similar to 

1-butanol, if peak is 

higher than the 

interference (area > 2) 

the peak is considered 

to be ethanol. 

Use PeakSimple to 

measure height (mV) of 

the unique peak 

between 5.75 – 6.25 

min. Use the standard 

curve to calculate its 

peak area, from which a 

ratio (to the area of 

corresponding 

isobutanol) is obtained.  

The ratio is then used to 

calculate its 

concentration using the 

ethanol standard curve. 

Acetone 6.65 – 7.05 If there is a “bump” at 

6.65- 7.05 min, acetone 

is indicated to be 

present.  

Obtain height of peak 

(mV) at ~6.35 min 

using PeakSimple. 

Account for 

isopropanol impurity 

height interference 

(0.007 mV) and ethanol 

height. Multiply the 

area per mV value of 

acetone to get the area. 

Use the mix isobutanol 

peak area to obtain 

peak ratio value. 

Concentration can be 

calculated using the 

acetone standard curve. 

Isopropanol 8.35 – 8.40 If there is a peak at 8.35 

– 8.40 min, isopropanol 

is indicated to be 

present.  

Use PeakSimple to 

measure the height 

(mV) of the unique 

peak between 8.35 – 

8.40 min. Use the 

standard curve to 

calculate its peak area, 

from which a ratio (to 
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the area of 

corresponding 

isobutanol) is obtained.  

The ratio is then used to 

calculate its 

concentration using the 

isopropanol standard 

curve. 

 

 

The standard curve for 1-butanol was obtained (Fig. 22), and its concentrations in both 

individual and mixed samples were proportional to their corresponding areas (Fig. 23).  

 

 

Figure 22. 1-Butanol standard curve from gas chromatography (peak ratio vs. concentration). 

Individual and mixed 1-butanol standard samples compared. GC sample points an average of duplicates. 

Error bars shown as ± standard deviation. 
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(a) 

 
 

(b) 

 

Figure 23. 1-Butanol standard curve from gas chromatography (area vs. concentration). (a) 1-

Butanol area of an individual (containing just 1-butanol) standard sample and corresponding 

concentration (mM), (b) 1-Butanol calculated area in a mixed (containing the same concentration of 

acetone, ethanol, isopropanol, and 1-butanol) standard sample and corresponding calculated concentration 

(mM). GC sample points are an average of duplicates. Error bars shown as ± standard deviation. 

y = 541.29x
R² = 1

0

500

1000

1500

2000

2500

3000

0 1 2 3 4 5 6

A
re

a

Concentration (mM)

y = 544.15x
R² = 0.9999

0

500

1000

1500

2000

2500

3000

0 1 2 3 4 5 6

C
al

cu
la

te
d

 A
re

a

Concentration (mM)



 

  53 

A height (mV) of each signature peak was found to be proportional to its corresponding peak 

area, which was also proportional to its corresponding concentration (Fig 24 - 26). Such 

signature peaks were used for identifying the presence of each solvent in the mix peak. The sum 

of the calculated peak area of each component from the mix peak was found to be approximately 

the same as the total peak area of the mix peak that was obtained by integration using the 

PeakSimple software (Table 8), with a less than 10% difference for all values. Therefore, the 

same approach was applied to analyzing the H. butylicus samples. Standard curves for ethanol, 

isopropanol, and acetone were prepared accordingly (Fig. 27 – 29). 

 

 

Figure 24. Comparison of ethanol height (mV) and corresponding concentration (mM). Individual 

and mixed ethanol (containing the same concentration of acetone, ethanol, isopropanol, and 1-butanol) 

standard samples compared. GC sample points an average of duplicates. Error bars shown as ± standard 

deviation. 
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Figure 25. Comparison of acetone height (mV) and corresponding concentration (mM). Individual 

and mixed acetone (containing the same concentration of acetone, ethanol, isopropanol, and 1-butanol) 

standard samples compared. GC sample points are an average of duplicates. Error bars shown as ± 

standard deviation. 

 

Figure 26. Comparison of isopropanol height (mV) and corresponding concentration (mM). 

Individual and mixed isopropanol (containing the same concentration of acetone, ethanol, isopropanol, 

and 1-butanol) standard samples compared. GC sample points are an average of duplicates. Error bars 

shown as ± standard deviation. 
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(a)                                                                                                                        b)  

            

(c) 

  

Figure 27. Ethanol standard curve from gas chromatography. (a) Ethanol area of a mixed (containing the same concentration of acetone, 

ethanol, isopropanol, and 1-butanol) standard sample and corresponding height (mV), (b) Mixed ethanol calculated area in a mixed (containing the 

same concentration of acetone, ethanol, isopropanol, and 1-butanol) standard sample and corresponding calculated concentration (mM), (c) 

Ethanol calculated peak ratio to calculated concentration (mM). GC sample points are an average of duplicates. Error bars shown as ± standard 

deviation. 

y = 24.564x
R² = 1

0

50

100

150

200

250

300

350

400

450

500

0 5 10 15 20

C
al

cu
la

te
d

 A
re

a

Height (mV)

y = 86.973x
R² = 0.9996

0

50

100

150

200

250

300

350

400

450

500

0 1 2 3 4 5 6

A
re

a

Concentration (mM)

y = 1.3298x
R² = 1

0

1

2

3

4

5

6

7

0 1 2 3 4 5 6

C
al

cu
la

te
d

 P
ea

k 
R

at
io

 
(C

al
cu

la
te

d
 S

o
lv

en
t/

M
ix

ed
 

Is
o

b
u

ta
n

o
l)

Calculated Concentration (mM)



 

  56 

(a)                                                                                                                        b)  

            

(c) 

 

Figure 28. Acetone standard curve from gas chromatography. (a) Acetone area of a mixed (containing the same concentration of acetone, 

ethanol, isopropanol, and 1-butanol) standard sample and corresponding height (mV), (b) Mixed acetone calculated area in a mixed (containing the 

same concentration of acetone, ethanol, isopropanol, and 1-butanol) standard sample and corresponding calculated concentration (mM), (c) 

Acetone calculated peak ratio to calculated concentration (mM). GC sample points are an average of duplicates. Error bars shown as ± standard 

deviation. 
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(a)                                                                                                                        b) 

             

(c)  

 

Figure 29. Isopropanol standard curve from gas chromatography. (a) Isopropanol area of a mixed (containing the same concentration of 

acetone, ethanol, isopropanol, and 1-butanol) standard sample and corresponding height (mV), (b) Mixed isopropanol calculated area in a mixed 

(containing the same concentration of acetone, ethanol, isopropanol, and 1-butanol) standard sample and corresponding calculated concentration 

(mM), (c) Isopropanol calculated peak ratio to calculated concentration (mM). GC sample points are an average of duplicates. Error bars shown as 

± standard deviation.
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Table 8. Comparison of ethanol, acetone, and isopropanol peak area. Values are an average of 

duplicates.   

Individual 

Acetone Peak 

Area 

Individual 

Ethanol Peak 

Area 

Individual 

Isopropanol 

Peak Area 

Sum of 

Individual AEI 

Peak Area 

Mixed AEI 

Peak Area 

Difference 

(%) 

0 0 0 0 0 0 

66.25 ± 5.89 18.26 ± 0.09 58.57 ± 3.14 143.07 ± 2.76 146.45 ± 5.05 2.33 

130.20 ± 3.52 37.98 ± 0.62 119.95 ± 1.49 288.14 ± 5.64 290.47 ± 1.68 0.81 

264.83 ± 4.80 82.96 ± 1.05 245.43 ± 3.45 1186.02 ± 2.40 1298.52 ± 4.44 9.06 

808.86 ± 2.47 245.49 ± 3.45 729.11 ± 3.78 1783.45 ± 2.81 1800.56 ± 8.45 0.95 

1331.26 ± 2.46 411.76 ± 1.29 1228.02 ± 8.37 2971.03 ± 7.21 3115.83 ± 8.01 4.76 

 

Table 9. Comparison of 1-butanol peak area. Values are an average of duplicates. 

Individual Butanol Peak Area Mixed Butanol Peak Area Difference (%) 

0 0 0 

128.25 ± 1.22 132.51 ± 0.88 3.27 

263.98 ± 3.38 267.74 ± 0.36 1.41 

539.08 ± 0.88 549.67 ± 4.91 1.95 

1625.61 ± 4.06 1635.06 ± 3.68 0.58 

2706.90 ± 4.32 2719.30 ± 3.25 0.46 
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3.2 Solvent production of H. butylicus  

3.3.1 Solvent production under optimized growth conditions 

Production of solvents by H. butylicus under optimal growth conditions was observed using gas 

chromatography. Concentrations for each solvent was calculated using the standard curves 

shown in Section 3.2.3. The different time points tested corresponds to the different growth 

phases of H. butylicus. Production of ethanol and 1-butanol began at the early-log phase of 

growth (before 16 hours) and began to plateau shortly after the stationary late-log phase (after 40 

hours). Production of isopropanol appeared to be linked to the production of acetone, where 

solvent production began during the mid-log phase (after 16 hours) for isopropanol and acetone 

production significantly decreased during the late-log phase (after 40 hours) (Fig. 30).
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Figure 30. Solvent production by H. butylicus under optimal growth conditions. Cells were grown under the same composition of media and 

3.0 atm of H2 (over-pressurized). GC sample points are from two biological replicates, each an average of duplicate GC samples. Error bars shown 

as ± standard deviation.
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3.3.2 Solvent production in the presence of butyrate 

The effect of butyrate supplemented medium on solvent production in H. butylicus was 

examined. Five- and 15-mM of butyrate were added to the medium described in Section 2.3 prior 

to inoculation. Production of solvents was detected using GC, and concentrations were 

determined using the standard curves described in Section 3.2.3. Relative to the solvent 

production under normal growth conditions (in the absence of butyrate), all solvents except for 

1-butanol showed a similar rate of solvent production (Fig. 31). In the case of 1-butanol, the 

addition of butyrate appeared to cause a significant increase in 1-butanol production (Fig. 31). 

Solvent production in H. butylicus supplemented with 15 mM of butyrate resulted in the highest 

1-butanol production which was approximately 6 times greater than under normal conditions. 

Although the addition of butyrate appeared to enhance the production of 1-butanol, the 

concentration of butyrate did not result in a corresponding equivalent production of 1-butanol 

(i.e., 5 mM butyrate does not equal an additional 5 mM production of 1-butanol) (Fig. 31).
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Figure 31. Comparison of solvent production by H. butylicus in butyrate supplemented media. Cells were grown under the same composition 

of media and 3.0 atm of H2 (over-pressurized). GC sample points are from two biological replicates, each an average of duplicate GC samples. 

Error bars shown as ± standard deviation.
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3.3.3 Solvent production in the presence of acetate 

The effect of acetate supplemented medium on solvent production in H. butylicus was examined. 

Five- and 15-mM of acetate were added into the medium described in Section 2.3 prior to 

inoculation. Production of solvents was detected using GC, and their concentrations was 

determined using the standard curves described in Section 3.2.3. Due to the less growth observed 

in the presence of acetate (see: Section 3.1.3), all solvents except ethanol showed lower 

production of solvents under the normal growth condition (in the absence of acetate). Similar to 

the addition of butyrate, the addition of acetate did not appear to result in a corresponding 

equivalent production of ethanol (i.e., 5 mM acetate does not equal an additional 5 mM 

production of ethanol) (Fig. 32). 
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Figure 32. Comparison of solvent production by H. butylicus in acetate supplemented media. Cells were grown under the same composition 

of media and 3.0 atm of H2 (over-pressurized). GC sample points are from two biological replicates, each an average of duplicate GC samples. 

Error bars shown as ± standard deviation. 
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4.0 Discussion 

H. butylicus is one of few hyperthermophiles capable of producing 1-butanol as a fermentation 

end-product. An alcohol dehydrogenase (Hbut_0414) has recently been found to be responsible 

for the production of 1-butanol in H. butylicus (Tse 2016), however, the pathway for 1-butanol 

production in this microorganism is unknown. Preliminary results using high performance liquid 

chromatography have shown acetone, ethanol, and isopropanol were produced as additional end-

products in H. butylicus (Tse 2016), providing a basis for this study. Throughout this thesis 

research, solvent production of H. butylicus was studied to gain a more thorough understanding 

of the metabolism of this microorganism. 
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4.1 Optimal growth conditions for H. butylicus 

H. butylicus is a hyperthermophilic archaeon that grows optimally between 95C and 106C 

(Zillig et al. 1990). It was determined in this study that a pH of 7.0 provided the highest growth 

(Section 3.1.1: Fig. 13), a maximum cell density of 2.48 x 108 cells/mL which is similar to what 

was reported previously (2.2 x 108 cells/mL) (Zillig et al. 1990). Growth of H. butylicus is 

reported to be stimulated by the addition of H2 (Zillig et al. 1990). Molecular H2 is known to be 

one of the most energetic substrates found in deep terrestrial subsurface environments (Libert et 

al. 2011). It is a common energy source for archaea and bacteria that are able to oxidize 

hydrogen under aerobic or anaerobic conditions, where energy is gained via the fixation of 

carbon when reacting with H2 (or CO2) (Libert et al. 2011). The supplementation of H2 has 

shown to enhance growth in the bacterium Campylobacter jejuni through the action of a 

hydrogenase (Weerakoon et al. 2009). The hydrogenases in H. butylicus aid in the reduction of 

sulfur and H2 to H2S (Brugger et al. 2007) while concomitantly providing energy to enhance cell 

growth. The addition of 3.0 atm of H2 (over-pressurized) resulted in the highest growth (Section 

3.1.1: Fig. 14) indicating that when more H2 is added, a higher level of growth is obtained. A H2 

pressure greater than 3.0 atm (over-pressurized) was not tested because of safety and handling 

concerns, however, 3.0 atm was sufficient in providing a similar maximum cell density, as 

previously reported. When comparing the cell densities to cultures grown under 3 psi of H2 

(over-pressurized), a 58% lower level of cell density relative to what was observed with the 

higher level of H2 (Section 3.1.1: Fig. 14), which is similar to previous reports (Zillig et al. 

1990, Tse 2016). 

 

The addition of sulfur has also been reported to stimulate the growth of H. butylicus (Zillig et al. 

1990), a past result which was confirmed in this study (Section 3.1.1: Fig. 15). A sulfur 

concentration of 10.0 g/L resulted in the highest amount of growth and a correlation between 

growth and sulfur concentration was observed (i.e., higher sulfur concentrations result in a higher 

cell density) (Section 3.1.1: Fig. 15). Previous reports used a continuous flow of H2 (200 kpa or 

1.97 atm) and a high-pressure resistant fermenter during the growth of H. butylicus (Zillig et al. 

1990). Although no continuous flow or high-pressure fermenter was used, a similar high cell 

density was achieved in this study. The previous reported generation time of this microorganism 

was 2.5 hours in the presence of sulfur and H2 (Zillig et al. 1990), however, a generation time of 
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4.4 hours was calculated in the present study. The longer generation time may be a result of 

deviations from the growth conditions previously reported. 

 

Once optimal pH and the best conditions for H2 pressure and sulfur concentration were 

determined, H. butylicus cultures were grown under the conditions reported herein, a series of 

replicated tests showed that these conditions were optimal for growth and were replicable. Under 

these conditions a cell density greater than 1.0 x 108 cells/mL could be achieved, thereby 

enabling the further study of solvent production by H. butylicus.  

 

There is some debate as to whether H. butylicus is capable of solvent production (Poehlein et al. 

2017). A study by Zimmermann (2013) reports no butanol production was found in H. butylicus 

cultures grown in the laboratory. In the study, HPLC analysis was used to determine solvent 

production (Zimmermann 2013). The detection limit, however, was unclear resulting in difficulty 

determining the sensitivity of the method. Additionally, the growth curve produced for H. 

butylicus cultures was significantly lower (maximum of 1.0 x 106 cells/mL) than that reported by 

Zillig et al. (1990) (maximum of 2.0 x 108 cells/mL). As further discussed in Section 4.3, solvent 

production in H. butylicus appears to be strongly dependent on growth thus, non-optimal growth 

conditions may have attributed to a much lower production of solvents and would furthermore 

require a much more sensitive method for their detection. For these reasons, the conclusion that 

H. butylicus does not produce butanol, as reported by Zimmermann (2013) cannot be 

substantiated. 
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4.2 Effect of acetate and butyrate on the growth of H. butylicus 

With cultures of H. butylicus reported to produce ethanol, acetone, isopropanol, and 1-butanol as 

fermentation end-products (Tse 2016), various concentrations of sodium butyrate and sodium 

acetate were added to the medium to determine their effect on the growth of H. butylicus. 

Cultures grown in butyrate supplemented media displayed no significant differences in cell 

density relative to growth under optimal conditions (Section 3.1.1: Fig. 16). A similar test was 

conducted using the acetone-butanol-ethanol (ABE) producer C. beijerinckii NCIMB 8052 

where growth was observed following the supplementation of 40 mM of butyrate into media 

(Wang et al. 2013). In the case of C. beijerinckii NCIMB 8052, the culture grew rapidly to the 

exponential phase compared to the culture grown in un-supplemented media where there was an 

obvious lag phase (Wang et al. 2013). Butyric acid (pKa = 4.91) is considered an organic waste 

product and reported to be the most prevalent organic waste product of anaerobic digestion by C. 

beijerinckii (Cho et al. 2019). Additionally, studies have shown that supplementing 18 mM of 

butyrate into culture media prevented strain degeneration (Lee et al. 2008). If H. butylicus is able 

to withstand the presence of this organic acid, this may prove beneficial for waste organic acid 

consumption. 

 

Cultures grown in acetate supplemented media, however, displayed a more noticeable change. 

When 5 mM of sodium acetate was supplemented into H. butylicus media, a 43% decrease in the 

maximum cell density was observed compared to cultures grown under optimal conditions 

(Section 3.1.2: Fig. 18). A larger decrease was observed for cultures supplemented with 15 mM 

sodium acetate, where a 75% decrease in maximum cell density was observed (Section 3.1.2: 

Fig. 18). Sodium acetate has a pKa of 4.54 (Neavyn et al. 2013). The exact reason for why the 

cell density decreased upon the addition of acetate is unknown. A possibility for the decreased 

cell density is that the concentration of acetate was debilitating for the culture, however, is 

unlikely as the same concentration of sodium butyrate was used for the sodium acetate 

experiment, and the former did not have any noticeable effect on cell growth. Experimental error 

cannot be excluded and may be a possible reason for the decrease in growth. Culture bottles may 

have been contaminated with oxygen (possibly) from a leak in the manifold, improper sealing of 

the bottles, or other similar technical reasons that may have resulted in a decrease in growth as 

well. Even trace amounts of oxygen are toxic to strictly anaerobic organisms (White 2000) and 
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would be extremely debilitating to the cell culture. Although a few possibilities were discussed, 

the definitive reason for a decreased cell density from acetate addition remains unknown. Further 

experimentation is required to fully understand these results.  
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4.3 Dependency of solvent production by H. butylicus on growth conditions 

Optimizing conditions of growth were crucial to obtaining the maximum cell growth and 

ultimately, maximum solvent production by H. butylicus. Prior to optimization, growth was 

variable and often non-reproducible. This was a result of inconsistencies in methodological and 

experimental procedures during culturing. Several issues resulted in poor growth including 

incorrect adjustment of pH, contamination of oxygen into culture samples, and variations in 

sulfur used. Although sulfur stimulates growth and is not required for growth (Zillig et al. 1990), 

it was surprising to find how significant the “correct” sulfur used was for the growth of H. 

butylicus in this study. Through a series of trials, precipitated sulfur from Sigma-Aldrich was the 

only sulfur that sufficiently stimulated growth. The exact reason for this is unknown. Once all 

conditions were optimized and reproducible high cell growth was achieved, solvent experiments 

were conducted. 

Preliminary HPLC analyses found that acetone, isopropanol, and butyrate were produced by H. 

butylicus (and that their production was growth-dependent) (Tse 2016), in addition to 1-butanol 

and acetate (Zillig et al. 1990). The present study confirmed these results using GC analyses and 

additionally, detected ethanol as a fermentation end-product. Similarly, 1-butanol, acetone, and 

isopropanol production were dependent on cell density where an increase in cell density 

correspondingly resulted in an increase in solvent production. Cell density-dependent solvent 

production was also observed for ethanol production. A drop in acetone production was observed 

following the late-log phase (Section 3.3.1: Fig. 30). It is suspected that the reduction of acetone 

resulted in the production of isopropanol possibly catalyzed by an alcohol dehydrogenase, as was 

previously observed in C. beijerinckii NRRL B593 (Ismaiel et al. 1993). From these results, it 

appears that there is an inherent connection between the metabolic activities and growth of H. 

butylicus. Experimental results indicate that a deviation from the optimal conditions affects both 

cell growth and solvent production. In some solvent producing clostridia, solvent production is 

dependent upon extracellular pH and has distinct “acidogenic” (resulted in a lower pH) and 

“solventogenic” (resulted in a higher pH) phases (Patakova et al. 2019). Other organisms require 

the production of intermediates to begin solvent production indicating that optimal growth 

conditions (including pH) must be in place (White 2000). An example of this is in butanediol 

fermentation, where the production of butanediol is favored under slightly acidic conditions as 
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this limits the decrease in external pH caused by the synthesis of organic acids (White 2000). In 

one study, the cultivation pH was found to play a significant role in the production of 2,3-

butanediol by the bacterial strain Klebsiella sp. Zmd30 and that controlling the pH at 6.0 

provided optimal solvent production (Wong et al. 2014). It was also found that butanediol 

production was dependent on growth (Wong et al. 2014), as was observed in H. butylicus. To 

elaborate this aspect, the effect of varying growth conditions (including pH) on the metabolism 

of H. butylicus needs to be investigated through further biochemical and genetic studies. 
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4.4 Stimulation of H. butylicus solvent production in the presence of acetate and butyrate 

Acetate and butyrate were previously detected as end-products of H. butylicus metabolism (Zillig 

et al. 1990; Tse 2016). The presence of these organic acids suggests the possibility of them being 

produced in vivo, which may be then converted into the corresponding alcohols (Blamey and 

Adams 1993; Huber et al. 1995; Nissen and Basen 2019). 

 

Cultures of H. butylicus were supplemented with 5- and 15-mM concentrations of sodium 

butyrate and sodium acetate, respectively, to determine the effect on solvent production. In the 

butyrate supplemented culture, similar amounts of solvent production were observed for ethanol, 

acetone, and isopropanol. For production of 1-butanol, a significant increase was observed with 

15 mM butyrate resulting in an approximately 167% increase (at maximum concentration) 

compared to cultures without any butyrate addition (Section 3.3.2 Fig. 31). The addition of 5 

mM butyrate resulted in an approximately 67% increase (at maximum concentration) (Section 

3.3.2 Fig. 31). This is an indication that H. butylicus may possess mechanisms to allow for the 

reduction of butyrate to produce 1-butanol. There is a possibility that an aldehyde:oxidoreductase 

(AOR) is responsible for this conversion, as was observed in C. beijerinkcii NCIMB 8052 and P. 

furiosus (Wang et al. 2013; Basen et al. 2014) (see: Section 1.2.3). 

 

In the acetate supplemented culture, similar levels of production of acetone, isopropanol, and 1-

butanol were observed. The production of ethanol however, showed a significant increase from 

the addition of acetate addition (Section 3.3.3 Fig. 32). The addition of 5 mM acetate resulted in 

an approximately 111% increase in ethanol production while addition of 15 mM acetate resulted 

in an approximately 148% increase addition (Section 3.3.3 Fig. 32). Similar to what was 

observed in the butyrate supplemented culture, the reduction of acetate to ethanol may have been 

catalyzed by an AOR (or an AOR-like) enzyme in H. butylicus. In this instance, solvent 

production appeared to start later and reach maximum concentration later than what was 

observed in cultures grown without acetate, which may be related to the decreased growth rate 

observed in acetate supplemented cultures. 

 

To explore this possibility, potential homolog genes for AOR were searched for in the H. 

butylicus genome. Four AOR proteins were found in the P. furiosus genome and run against the 
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H. butylicus genome (Table 10). The highest AOR identity was found in the Hbut_0737 gene 

(48.54%), which was identified to be an “aldehyde ferredoxin oxidoreductase family protein”. 

Although this gene has not been characterized, there is potential for this AOR to play a key role 

in organic acid conversions in H. butylicus. 

Table 10. Potential P. furiosus AOR homologs in H. butylicus  

Protein in P. furiosus 

(Accession number) 

Protein in H. butylicus (Accession 

number) 

H. butylicus 

gene 

Percent 

Identity 

Tungsten-containing 

aldehyde ferredoxin 

oxidoreductases (Q51739.1) 

 

Aldehyde ferredoxin oxidoreductase 

family protein (WP_011822166.1) 

Hbut_0737 48.54 

Aldehyde ferredoxin oxidoreductase 

family protein (WP_011822692.1) 

Hbut_1553 35.24 

Aldehyde ferredoxin oxidoreductase 

family protein (WP_011821541.1) 

Hbut_0351 34.15 

Aldehyde ferredoxin oxidoreductase 

family protein (WP_110138747.1) 

Hbut_1001 34.82 

Aldehyde:ferredoxin 

oxidoreductase 

(CAA56170.1) 

Aldehyde ferredoxin oxidoreductase 

family protein (WP_011822166.1) 

Hbut_0737 48.54 

Aldehyde ferredoxin oxidoreductase 

family protein (WP_011822692.1) 

Hbut_1553 35.24 

Aldehyde ferredoxin oxidoreductase 

family protein (WP_011821541.1) 

Hbut_0351 34.15 

Aldehyde ferredoxin oxidoreductase 

family protein (WP_110138747.1) 

Hbut_1001 34.82 

Aldehyde:ferredoxin 

oxidoreductase (aor) 

(AAL80470.1) 

Aldehyde ferredoxin oxidoreductase 

family protein (WP_011822166.1) 

Hbut_0737 48.54 

Aldehyde ferredoxin oxidoreductase 

family protein (WP_011822692.1) 

Hbut_1553 35.24 

Aldehyde ferredoxin oxidoreductase 

family protein (WP_011821541.1) 

Hbut_0351 34.15 

Aldehyde ferredoxin oxidoreductase 

family protein (WP_110138747.1) 

Hbut_1001 34.82 

Tungsten-containing 

glyceraldehyde-3-

phosphate ferredoxin 

oxidoreductase 

(Q8U3K2.1) 

Aldehyde ferredoxin oxidoreductase 

family protein (WP_110138747.1) 

Hbut_1001 25.17 

Aldehyde ferredoxin oxidoreductase 

family protein (WP_011822692.1) 

Hbut_1553 25.18 

Aldehyde ferredoxin oxidoreductase 

family protein (WP_011821541.1) 

Hbut_0351 23.90 

Aldehyde ferredoxin oxidoreductase 

family protein (WP_011822166.1) 

Hbut_0737 23.16 

 

Low concentrations of acetate and butyrate have previously been reported in H. butylicus (Zillig 

et al. 1990; Tse 2016), suggesting a possible mechanism may exist for butyrate and acetate 

conversion in the organism. This pathway may look similar to the pathway proposed by Nissen 

and Basen (2019) involving and AOR and ADH (Section 1.2.3: Fig. 5).  
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4.5 Proposed pathways and key enzymes involved in solvent production by H. butylicus 

The vast majority of the butanol production pathway (and enzymes involved) in H. butylicus 

currently remains unknown. In efforts to better understanding this hyperthermophile’s 

metabolism, different pathways for solvent production were explored. 

 

With end-products of H. butylicus baring similarity to those of C. beijerinckii (formerly called 

“C. butylicum” and also the reason why the organism was named “Hyperthermus butylicus”) 

(Zillig et al. 1990), it is speculated that there may be a link between the two microorganisms. A 

search of the genomes of C. acetobutylicum ATCC 824 and H. butylicus, however, showed no 

significant homologs for the key enzymes of butanol production (butyryl-CoA dehydrogenase, β-

hydroxybutyryl-CoA dehydrogenase, acetoacetyl-Co:acetate:CoA-transferase, acetoacetyl-

CoA:butyrate:CoA transferase, and butyraldehyde dehydrogenase). Being from two separate 

domains, it is not surprising that no homologs were found between C. acetobutylicum ATCC 824 

and H. butylicus. Nevertheless, this is an indication that a novel pathway or enzymes with 

catalytic functions, but with no or very low sequence similarity for 1-butanol production, is 

present in H. butylicus, warranting further investigation.  

 

Potential enzymes for solvent production in H. butylicus were searched using HMMs (Hidden 

Markov Model) (Appendix A: Gene Sequence Analysis). HMM searching summarizes 

functional information using whole families of proteins as profiles, rather than single queries 

through BLAST sequence searching. HMM searches against profiles of key enzymes for butanol 

production in C. acetobutylicum ATCC 824, S. cerevisiae S288c, and E. coli BW25113 (as 

previously discussed in the Introduction: Section 1.2.1 – 1.24) were performed. From the search, 

percent identity hits (< 60%) were the following: pyruvate:ferredoxin oxidoreductase, acetyl-

CoA acetyltransferase, beta-hydroxybutyryl-CoA dehydrogenase, butryaldehyde dehydrogenase, 

butanol dehydrogenase, 2-isopropylmalate dehydrogenase, 2-ketoacid decarboxylase, glycine 

oxidase, and pyruvate decarboxylase.  

 

The key enzymes for ABE production in C. acetobutylicum ATCC 824, acetoacetyl-

CoA:acetate-CoA-transferase and acetoacetyl-CoA:butyrate-CoA-transferase, did not show any 

significant similarity from the search suggesting that there may be an alternative pathway for 
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production. The experimental data showed a corresponding increase in ethanol and 1-butanol 

from the addition of acetate and butyrate thus, it is possible that an AOR-like enzyme is present 

in H. butylicus. The function of AORs in hyperthermophiles is thought to catalyze the reversible 

oxidation of aldehydes (Basen et al. 2014). The possibility of the enzyme catalyzing the 

conversion of organic acids to their corresponding aldehyde was previously discussed and 

demonstrated in vivo (Heider et al. 1994; Keller et al. 2017). H. butylicus utilizes peptides as a 

growth substrate (Zillig et al. 1990) indicating the possibility of the keto-acid pathway (found in 

S. cerevisiae) to be present. The pathway involves a pyruvate decarboxylase (PDC), which is 

essential for the biosynthesis of amino acids to butanol. There is also a possibility of a 

bifunctional enzyme with both PDC and POR activities present, which may concomitantly 

catalyze the production of pyruvate to acetaldehyde and acetyl-CoA, respectively (Eram et al. 

2014). In combination with research from other butanol producing microorganisms and the data 

obtained from this study, a hypothetical pathway for solvent production in H. butylicus was 

proposed (Fig. 33). Currently, no definite conclusion regarding the pathway for solvent 

production in H. butylicus can be made. However, the potential involvement of an AOR-like 

enzyme for the conversion of organic acids has been proposed from this study.  
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Figure 33. Proposed pathway for solvent production in H. butylicus. Detected solvents are indicated 

in bold (ethanol, acetone, isopropanol, 1-butanol). Italicized enzymes are potentially present (AOR: 

aldehyde:oxidoreductase; POR: pyruvate:ferredoxin oxidoreductase; PDC: pyruvate decarboxylase; 

ADH: alcohol dehydrogenase; ACAT: acetyl-CoA acetyltransferase/Thiolase; HBD: beta-

hydroxybutyryl-CoA dehydrogenase; BADH: butryladehyde dehydrogenase; BDH: butanol 

dehydrogenase); (Adapted from Garcia et al. 2011; Branduardi et al. 2013; Al-Shorgani et al. 2012; 

Nissen and Basen 2019). 
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4.6 Conclusions 

The aims of this study were to broaden the understanding of the metabolism of H. butylicus, and 

to also contribute to the ongoing efforts in finding an alternative renewable energy source to 

replace petroleum-based sources. From this study the following conclusions were made:  

 

1) Conditions of growth including pH, concentration of sulfur, and H2 pressure were 

optimized for H. butylicus. Optimal growth conditions were found to be the following: 

pH 7.0, 10.0 g/L of sulfur, 3.0 atm of H2. 

 

2) 2) Production of acetone, ethanol, isopropanol, and 1-butanol by H. butylicus was 

confirmed using GC analysis. Solvent production was growth-dependent, sharing 

significant similarity to that in clostridial species, however, no significant homologs for 

the key enzymes of butanol production were found. This suggests an alternative pathway 

for solvent production in H. butylicus is likely present. 

 

3) The addition of organic acids such as sodium acetate and sodium butyrate to the culture 

media significantly stimulated the production of ethanol and 1-butanol, respectively. 

 

4) In combination with existing butanol production pathways and experimental results from 

this study, potential pathways for H. butylicus were proposed. Due to the similarity in 

end-products to clostrial species, an alternative ABE pathway may be present. Without 

any significant homologs for acetoacetyl-CoA:acetate-CoA-transferase and acetoacetyl-

CoA:butyrate-CoA-transferase present in H. butylicus, novel enzymes and/or pathways 

are likely present. H. butylicus utilizing peptides as a growth substrate brings the 

possibility for the keto-acid pathway to be present involving a PDC-like enzyme, which 

is essential for the production of 1-butanol from 2-ketovalterate. Lastly, H. butylicus 

possess the ability to utilize the organic acids acetate and butyrate to increase the 

production of ethanol and 1-butanol, respectively, suggesting a butyraldehyde 

dehydrogenase and/or an AOR/ADH pathway may be present. 
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4.7 Future Prospects 

The confirmation of solvent production by H. butylicus provides a foundation to further explore 

its metabolic features. The proposed pathways are of significant interest in future research. A few 

possible areas can be considered for future studies:  

 

1) Biochemical determination of key enzymes in various pathways and/or further genome 

sequencing analysis. As only solvent production was studied in this thesis, biochemical 

experimentation (measuring catalytic activity from cell-free extract of H. butylicus) is 

required to determine which enzymes are present to be further tested for purification and 

characterization. From bioinformatic analyses, several predicted enzymes have the 

potential to be involved in H. butylicus’ solvent production: pyruvate:ferredoxin 

oxidoreductase, acetyl-CoA acetyltransferase, beta-hydroxybutyryl-CoA dehydrogenase, 

butryaldehyde dehydrogenase, butanol dehydrogenase, 2-isopropylmalate dehydrogenase, 

2-ketoacid decarboxylase, glycine oxidase, and pyruvate decarboxylase. 

 

2) Quantify acetate and butyrate concentration consumed and remaining following 

supplementation at varying concentrations. From the experimental results, it was 

determined that the amount of organic acid supplied did not equate to the amount 

consumed by H. butylicus. In this respect, quantifying the amount of organic acid 

consumed will support the solvent production data. Using GC or HPLC analysis, the 

extracellular concentration of acetate and butyrate could be detected to determine the 

amount remaining in the media (unconsumed concentration) then further, the amount 

consumed by the organism. 

 

3) Exploring pH dependency of solvent production with and without the addition of organic 

acids to verify if there might be “acidogenic” and “solventogenic” phases present in H. 

butylicus. 
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Appendix A 

Gene Sequence Analysis 

Potential homologs of genes in H. butylicus encoding key enzymes involved in butanol production in C. 

acetobutylicum ATCC 824. 

Target enzyme Key Enzyme for 

butanol production in 

C. acetobutylicum 

ATCC 824 

(locus tag) 

Potential homologous 

gene in H. butylicus 

DSM 5456 (old locus 

tag) 

E-value Percent 

identity 

(%) 

Pyruvate:ferredoxin 

oxioreductase 

CA_C2499 Hbut_0730 8e-38 28.03 

Acetyl-CoA 

acetyltransferase 

CA_C2873  Hbut_1528 1e-11 23.33 

β -hydroxybutyryl-

CoA dehydrogenase 

CA_C2708   Hbut_0193 2.8 33.33 

Crotonase CA_C2712 No significant hits N/A N/A 

3-hydroxybutyryl-

CoA dehydrogenase 

CA_C2712 

CA_C2708 

Hbut_1001 

Hbut_0914 

2.8 

2.8 

17.39 

25.71 

Acetoacetyl-

CoA:acetate:CoA-

transferase 

X X X X 

Acetoacetyl-

CoA:butyrate:CoA 

transferase 

CA_P0163 No significant hits N/A N/A 

Acetoacetate 

decarboxylase 

CA_P0165 Hbut_0896 7.9 40.00 

Butyraldehyde 

dehydrogenase 

AAD04638.1* No significant hits N/A N/A 

Butanol 

dehydrogenase 

CA_C3298 

CA_C3299 

CA_C3392 

No significant hits 

Hbut_0094 

No significant hits 

N/A 

0.47 

N/A 

N/A 

19.00 

N/A 

 Key enzymes were searched in the C. acetobutylicum ATCC 824 genome (Taxonomy ID: 272562) and potential 

homologs were obtained using BLASTp searches of genes in H. butylicus DSM 5456 (Taxonomy ID: 415426). 

Percent identity obtained using Jalview by performing pairwise alignments on sequences of interest. *locus tag not 

identified in genome. 

 

 

Potential homologs of genes in H. butylicus encoding key enzymes involved in butanol production in S. 

cerevisiae S288c. 

Target enzyme Key Enzyme for 

butanol production 

in S. cerevisiae S288c 

(locus tag) 

Potential homologous 

gene in H. butylicus (old 

locus tag) 

E-value Percent 

identity 

(%) 

Glycine oxidase** BSU11670 Hbut_0730 1e-12 24.48 

Malate synthase YNL117W No significant hits N/A N/A 

3 –isopropylmalate 

dehydrogenase  

YCL018W  No significant hits N/A N/A 

Pyruvate 

decarboxylase 

YLR044C (PDC1) 

YLR134W (PDC5) 

No significant hits  

No significant hits 

N/A 

N/A 

N/A 

N/A 
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(PDC1, PDCC5, PDC6) YGR087C (PDC6) Hbut_0252 4.2 19.05 

Butanol dehydrogenase YMR303C No significant hits N/A N/A 

Key enzymes were searched in the S. cerevisiae S288c genome (Taxonomy ID: 4932) and potential homologs were 

obtained using BLASTp searches of genes in H. butylicus DSM 5456 (Taxonomy ID: 415426). Percent identity 

obtained using Jalview by performing pairwise alignments on sequences of interest. **Gene for glycine oxidase is 

from the Bacillus subtilis subsp. Subtilis str. 168 genome. 

 

 

Potential homologs of genes in H. butylicus encoding key enzymes involved in butanol production in E. coli 

BW25113. 

Target enzyme Key Enzyme for 

butanol production 

in E. coli BW25113 

(locus tag) 

Potential homologous 

gene in H. butylicus 

DSM 5456 (old locus 

tag) 

E-value Percent 

identity 

(%) 

Theronin dehydratase BW25113_0269 No significant hits N/A N/A 

2-isopropylmalate 

synthase 

BW25113_0074 No significant hits N/A N/A 

2-isopropylmalate 

isomerase 

BW25113_1180 Hbut_0220 1e-21 27.85 

3-isopropylmalate 

dehydrogenase 

BW25113_0073 Hbut_0799 8.4 28.21 

2-ketoacid 

decarboxylase* 

AAS49166 No significant hits N/A N/A 

Alcohol dehydrogenase 

2** 

YMR303C Hbut_1602 6.3 23.26 

Key enzymes were searched in the E. coli BW25113 genome (Taxonomy Id: 679895) and potential homologs were 

obtained using BLASTp searches of genes in H. butylicus DSM 5456 (Taxonomy ID: 415426). Percent identity 

obtained using Jalview by performing pairwise alignments on sequences of interest. *gene from L. lactis inserted 

into E. coli BW25113. **gene from S. cerevisiae S288c inserted into E. coli. 

 

 

HMMsearching with whole Pfam domains and archaea-only domains of key enzymes in C. acetobutylicum for 

butanol production. 
Key enzyme for 

butanol production 

Pfam Domains Pfam match e-value Percent 

identity 

(%) 

Pyruvate:ferredoxin 

oxioreductase 

PFOR_II Hbut_07301 

Hbut_06691 

 

Hbut_07302 

Hbut_06692 

Hbut_14552 

Hbut_16252 

5.6e-271 

1.6e-241 

 

5.8e-1392 

1.8e-1322 

4.8e-182 

2.2e-132 

50.51 

47.11 

 

47.22 

40.92 

30.52 

43.52 

EKR No hits for query N/A N/A 

Fer4_16 Hbut_01871 

Hbut_06681 

Hbut_13801 

Hbut_07311 

Hbut_10521 

8.4e-071 

1.3e-051 

7.6e-061 

1.8e-051 

0.000531 

45.01 

32.11 

50.01 

35.71 

25.91 
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TPP_enzyme_C Hbut_09831 

Hbut_14551 

Hbut_06701 

Hbut_16251 

Hbut_07291 

 

Hbut_16252 

Hbut_14552 

Hbut_09832 

Hbut_07292 

Hbut_06702 

Hbut_07302 

Hbut_06692 

8.0e-291 

9.7e-261 

6.7e-241 

2.0e-231 

2.1e-191 

 

8.1e-1502 

3.4e-1432 

7.9e-782 

6.7e-752 

5.0e-722 

9.9e-092 

1.9e-052 

33.81 

32.91 

30.31 

30.91 

23.31 

 

43.32 

45.82 

35.32 

36.92 

30.42 

32.62 

26.42 

Acetyl-CoA 

acetyltransferase 

N-terminal domain Hbut_15281 

 

Hbut_15282 

5.6e-211 

 

1.4e-1822 

30.31 

 

66.12 

C-terminal domain Hbut_15281 

 

Hbut_15282 

Hbut_15272 

5.6e-071 

 

1.9e-1662 

5.6e-052 

58.31 

 

58.22 

24.02 

β -hydroxybutyryl-

CoA dehydrogenase 

NAD binding domain Hbut_09121 

Hbut_10611 

Hbut_01931 

 

No significant 

sequences2 

0.111 

0.591 

0.671 

 

N/A2 

18.81 

40.71 

23.91 

 

N/A2 

C-terminal domain No significant 

sequences1 

 

No significant 

sequences2 

N/A1 

 

N/A2 

N/A1 

 

N/A2 

Crotonase 

 

Enoyl-CoA 

hydratase/isomerase domain 

No significant 

sequences1 

 

No significant 

sequences2 

N/A1 

 

N/A2 

N/A1 

 

N/A2 

3-hydroxybutyryl-

CoA dehydrogenase 

Enoyl-CoA 

hydratase/isomerase domain 

No significant 

sequences1 

 

No significant 

sequences2 

N/A1 

 

N/A2 

N/A1 

 

N/A2 

Acetoacetyl-

CoA:acetate:CoA-

transferase 

X X X X 

Acetoacetyl-

CoA:butyrate:CoA 

transferase 

CoA_trans domain No significant 

sequences1 

 

No significant 

sequences2 

N/A1 

 

N/A2 

N/A1 

 

N/A2 

Acetoacetate 

decarboxylase 

Acetoacetate decarboxylase No significant 

sequences1 

 

No significant 

sequences2 

N/A1 

 

N/A2 

N/A1 

 

N/A2 
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Butyraldehyde 

dehydrogenase 

Aldehyde dehydrogenase  No significant 

sequences1 

 

No significant 

sequences2 

N/A1 

 

N/A2 

N/A1 

 

N/A2 

 Iron-containing alcohol 

dehydrogenase  

No significant 

sequences1 

 

Hbut_15662 

N/A1 

 

3.8e-092 

N/A1 

 

22.42 

Butanol 

dehydrogenase 

Iron-containing alcohol 

dehydrogenase  

Hbut_15661 

 

No significant 

sequences2 

4.5e-21 

 

N/A2 

21.6 

 

N/A2 

1Found by HMMsearching whole Pfam domain 
2Found by HMMsearching Archaea-only domain 

E-values and percent identity are reported for key enzymes in C. acetobutylicum butanol production pathway. Raw 

HMM files from Pam were used for the whole Pfam searching, and sequence alignments for archaea-only domains 

were performing using the MUSCLE alignment method with Seaview. Rows marked with “X” indicate gene was not 

annotated in the genome. 
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HMMsearching with whole Pfam domains and archaea-only domains of key enzymes in S. cerevisiae S288c 

for butanol production. 
Key enzyme for 

butanol production 

Pfam Domains Pfam match e-value Percent 

identity 

(%) 

Glycine oxidase** FAD dependent 

oxidoreductase 

Hbut_06251 

Hbut_01801 

Hbut_08021 

Hbut_02531 

Hbut_04951 

 

Hbut_06252 

Hbut_08022 

Hbut_01802 

Hbut_12572 

Hbut_02532 

Hbut_10612 

Hbut_04952 

Hbut_00162 

1.2e-511 

8.9e-071 

3.7e-061 

0.00011 

0.00471 

 

4.1e-952 

3.1e-122 

2.0e-072 

8.1e-072 

2.6e-052 

0.00052 

0.000752 

0.00142 

34.21 

37.51 

41.91 

34.81 

36.41 

 

35.62 

36.12 

48.42 

24.62 

46.52 

42.92 

35.32 

36.82 

Malate synthase Malate synthase No significant sequences1 

 

No significant sequences2 

N/A1 

 

N/A2 

N/A1 

 

N/A2 

β –isopropylmalate 

dehydrogenase  

Isocitrate/isopropylmalate 

dehydrogenase 

No significant sequences1 

 

No significant sequences2 

N/A1 

 

N/A2 

N/A1 

 

N/A2 

Pyruvate 

decarboxylase 

(PDC1, PDC5, 

PDC6) 

 

Thiamine pyrophosphate 

enzyme, N-terminal TPP 

binding domain 

Hbut_16251 

Hbut_14551 

 

Hbut_14552 

Hbut_16252 

Hbut_09832 

0.0511 

0.0721 

 

6.0e-082 

0.000472 

0.0032 

24.71 

26.81 

 

26.72 

24.32 

25.22 

Thiamine pyrophosphate 

enzyme, central domain 

Hbut_16251 

Hbut_14551 

 

Hbut_06702 

0.0511 

0.0721 

 

0.472 

24.71 

26.81 

 

28.62 

Thiamine pyrophosphate 

enzyme, C-terminal TPP 

binding domain 

Hbut_09831 

Hbut_14551 

Hbut_06701 

Hbut_16251 

Hbut_07291 

 

Hbut_14552 

Hbut_16252 

Hbut_09832 

Hbut_07292 

Hbut_06702 

Hbut_07302 

8.0e-291 

9.7e-261 

6.7e-241 

2.0e-231 

2.1e-191 

 

2.4e-1712 

1.4e-1602 

3.8e-832 

1.7e-792 

2.8e-792 

0.000242 

33.81 

32.91 

30.31 

30.91 

23.31 

 

50.72 

46.32 

32.62 

36.32 

31.82 

36.62 



 

  92 

Butanol 

dehydrogenase 

Alcohol dehydrogenase 

GroES-like domain 

No significant sequences1 

 

Hbut_04142 

Hbut_04952 

N/A1 

 

1.3e-092 

4.4e-082 

N/A1 

 

28.72 

31.12 

1Found by HMMsearching whole Pfam domain 
2Found by HMMsearching Archaea-only domain 

E-values and percent identity are reported for key enzymes in S. cerevisiae S288c butanol production pathway. Raw 

HMM files from Pam were used for the whole Pfam searching, and sequence alignments for archaea-only domains 

were performing using the MUSCLE alignment method with Seaview. Rows marked with “X” indicate gene was not 

annotated in the genome. 

 

 
HMMsearching with whole Pfam domains and archaea-only domains of key enzymes in E. coli BW25113 for 

butanol production. 
Key enzyme for 

butanol production 

Pfam Domains Pfam match e-value Percent 

identity 

(%) 

Theronin 

dehydratase 

Dehydratase No significant sequences1 

 

No significant sequences2 

N/A1 

 

N/A2 

N/A1 

 

N/A2 

2-isopropylmalate 

synthase 

HMGL-like domain No significant sequences1 

 

No significant sequences2 

N/A1 

 

N/A2 

N/A1 

 

N/A2 

LeuA allosteric 

(dimerisation) domain 

No significant sequences1 

 

No significant sequences2 

N/A1 

 

N/A2 

N/A1 

 

N/A2 

2-isopropylmalate 

isomerase 

Fumarylacetoacetate 

(FAA) hydrolase family 

Hbut_02201 

 

Hbut_02202 

1.3e-501 

 

4.1e-502 

40.11 

 

37.82 

3-isopropylmalate 

dehydrogenase 

Isocitrate/isopropylmalate 

dehydrogenase 

No significant sequences1 

 

No significant sequences2 

N/A1 

 

N/A2 

N/A1 

 

N/A2 

2-ketoacid 

decarboxylase** 

Thiamine pyrophosphate 

enzyme, N-terminal TPP 

binding domain 

 

Hbut_16251 

Hbut_14551 

 

Hbut_14552 

Hbut_16252 

Hbut_09832 

0.0511 

0.0721 

 

6.0e-082 

0.000472 

0.0032 

24.71 

26.81 

 

26.72 

24.32 

25.22 

Thiamine pyrophosphate 

enzyme, central domain 

Hbut_16251 

Hbut_14551 

 

Hbut_06702 

0.0511 

0.0721 

 

0.472 

24.71 

26.81 

 

28.62 

Thiamine pyrophosphate 

enzyme, C-terminal TPP 

binding domain 

Hbut_09831 

Hbut_14551 

Hbut_06701 

Hbut_16251 

Hbut_07291 

 

Hbut_14552 

Hbut_16252 

Hbut_09832 

Hbut_07292 

8.0e-291 

9.7e-261 

6.7e-241 

2.0e-231 

2.1e-191 

 

2.4e-1712 

1.4e-1602 

3.8e-832 

1.7e-792 

33.81 

32.91 

30.31 

30.91 

23.31 

 

50.72 

46.32 

32.62 

36.32 
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Hbut_06702 

Hbut_07302 

2.8e-792 

0.000242 

31.82 

36.62 

Alcohol 

dehydrogenase 2* 

Alcohol dehydrogenase 

GroES-like domain 

No significant sequences1 

 

Hbut_04142 

Hbut_04952 

N/A1 

 

1.3e-092 

4.4e-082 

N/A1 

 

28.72 

31.12 

*gene from L. lactis inserted into E. coli BW25113. **gene from S. cerevisiae S288c inserted into E. coli BW25113. 
1Found by HMMsearching whole Pfam domain 
2Found by HMMsearching Archaea-only domain 

E-values and percent identity are reported for key enzymes in E. coli BW25113 butanol production pathway. Raw 

HMM files from Pam were used for the whole Pfam searching, and sequence alignments for archaea-only domains 

were performing using the MUSCLE alignment method with Seaview. Rows marked with “X” indicate gene was not 

annotated in the genome 
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Appendix B 

GC Operation Procedure 

Operating procedures for the use of Shimadzu GC-14a and PeakSimple software (version 4.51) 

Note: Shimadzu GC-14a is a stand-alone and manually operating instrument. Its chromatograph can be 

recorded either by an integrator using recording paper or using PeakSimple software (version 4.51) that is 

computer-controlled, which is part of another GC Buck. 

 

I. Turning on the Shimadzu GC-14a and get ready to use the PeakSimple software (version 4.51) 

*The GC is equipped with two columns connected to each other. The first column is the DB-5 followed by 

the DB-624. This combined column is optimal for detecting the following solvents: acetone, ethanol, 

butanol, isopropanol. The method currently set on the GC is the following: 

Injector temperature: 200 degrees C 

Detector temperature: 250 degrees C 

Initial temperature: 35 degrees C (hold for 10 min) 

Ramp: 3 degrees/min to 40 degrees C, 45 degrees C/min to 150 degrees C (hold for 1 min) 

Range: 1 for 10 min, 2 for 10 min, 1 for 10 min  

 

Entire program length: 30 min 

 

*The GC takes ~15-20 min to cool down. Do not inject another sample until the GC has fully cooled 

down and returned to the initial temperature (the current initial temperature set on the GC is 35 degrees 

C).  

**within the injector, there is a rubber septum that acts as a filter between the outside of the injection 

port and the glass column (contains glass wool which acts as an additional filter between the sample and 

column). This rubber septa must be changed regularly (between 150-200 punctures) to avoid 

contamination of the glass column.  
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1. Open the gas tanks (left to right) and set to the following pressures:  

 

Hydrogen tank          Helium tank                Nitrogen tank                      Air tank 

     psi = 30                     psi = 50                      psi = 20                           psi = 10 

 

2. Turn on the GC Buck by flipping the power switch located on the bottom right side of the machine.  
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3. Turn on the Shimadzu GC-14a by flipping the white power switch located at the bottom right of the 

machine. Depress the FID and Heater buttons to turn them on. 

 

 

4. Ignite the FID using a butane lighter. Place the lighter above the FID port, for a few seconds - and 

listen for a “pop” sound. Once the sound is heard, use a clean glass slide to check for condensation. If 

condensation is seen, you have successfully ignited the FID. If not, you need to repeat this step again.  

Once the FID is successfully ignited, press the red “START” button on the GC so the set temperatures 

can be achieved (it takes a few minutes for the oven temp, detector temp, injector temp to reach the set 

temps). You can check to see if they have reached the desired temps by selecting “MONIT”, followed by 

the desired current temp of each component (ie. COL, INJ, DET-T).  

 

 

 

 

 



 

  97 

5. Turn on the computer connected to the GC Buck to use the PeakSimple integration software. 

 

6. Once PeakSimple has opened, go to: “File” -> “Control File” -> select “25” located on the Desktop. 

7. Once this control file has been initialized, go to: “Edit” -> “Channels” -> Under “Channel 4: Channel 

4” -> “Events” -> “Add” -> “Reverse” -> select “OK” -> select “OK”. 

8. On the Shimadzu GC 14-a, press the “Range” button, then the number “1”.  

9. After the range changes from “4” (least sensitive) to “1” (second most sensitive) and the “Reverse” 

event has been added, press the spacebar twice (doing this changes the baseline from a negative mV to a 

positive mV”.  

10. The added “Reverse” event can now be removed. Go to: “Edit” -> “Channels” -> Under “Channel 4: 

Channel 4” -> “Events” -> “Remove” -> “Reverse” -> select “OK” -> select “OK”. 

11. Once the Shimadzu GC 14-a has reached the initial temperature, the LED beside “Ready” will turn 

on, and the GC is ready to be injected with your sample.  

12. Using a 10 µl gas-tight syringe, rinse the syringe with DI water. Obtain 1 µl of your sample, and 

carefully inject the needle into the injection port (ensure the needle does not bend). Once the sample has 

been injected, remove the needle from the injection port, and press the “START” button on the Shimadzu 

GC 14-a, while quickly pressing the spacebar of the keyboard after (this will start the recording on 

PeakSimple). 
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Note: you do not need to press the space bar to stop the recording, as PeakSimple has been set to stop 

once the program has completed on the GC (To set the program length time, go to:   “Edit” -> 

“Channels” -> Under “Channel 4: Channel 4” -> “Details” -> Under “End time: ”, enter length of 

program (in min) -> select “OK” -> select “OK”.) 

13. Once the sample has completed its run, save your recording. Go to: “File” -> “Save as” -> [name your 

file; ensure it is saved as a .CHR file and saved under Channel 4] -> “Save”.  

14. Steps 11-13 can be repeated for your next sample (ensure the LED light beside “Ready” is on before 

injecting again). 

 

II. Shutting down the GC Shimadzu GC-14a and close the PeakSimple software (version 4.51) 

1. Close PeakSimple software and shut down the computer (as normally done). 

2. Once the LED beside “ready” is on on the Shimadzu GC-14a, change the range on the GC from “1” 

back to “4”. 

3. Depress the FID and Heater button to turn them off. Flip the white power switch to “off” to turn off the 

GC. 

4. Close all gas tanks (in the order they were opened). 

5. Turn off the GC Buck by flipping the power switch to “off”.  

 

III. Shimadzu GC-14a Parameter Set up (to set a new program) 

 

To set a new program, input the following: 

Set the injector temperature:  

1. Press “INJ” -> enter desired injector temperature (in degrees C) using the number pad -> Press “ENT”. 

Set the detector (FID) temperature:  

1. Press “DET-T” -> enter desired detector temperature (in degrees C) using the number pad -> Press 

“ENT”. 

Set the initial temperature: 

1. Press “COL” -> Press “INIT TEMP” -> enter desired initial temperature (in degrees C) using the 

number pad -> Press “ENT”. 

2. If you want the initial temperature to hold for a certain amount of time: 

a) Press “COL” -> Press “INIT TIME” -> enter desired initial temperature hold time (in min) using 

the number pad -> Press “ENT”. 
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Set the ramp temperature/min rate: 

1.  Press “COL” -> Press “PROG RATE” -> enter the first desired temperature/min rate of the program 

(in degrees C/min) using the number pad -> Press “ENT” -> enter the second desired temperature/min 

rate of the program (in degrees C/min) using the number pad -> Press “ENT” -> [keep repeating until all 

the desired temperature/min rate of the program have been entered or stop at the second desired 

temperature/min rate]. 

Example: for the current set program, the program ramps at “3 degrees/min to 40 degrees C” then “45 

degrees C/min to 150 degrees C”. The following would be entered: 

 

Press “COL” -> Press “PROG RATE” -> enter “3” -> Press “ENT” -> enter “45” -> Press “ENT. 

2. Set the temperature the program rate goes up to: Press “COL” -> Press “FINAL TEMP” -> enter the 

first desired temperature for the first rate (in degrees C) using the number pad ->  Press “ENT” -> enter 

the second desired temperature for the second rate (in degrees C) using the number pad -> Press “ENT” -

> [keep repeating until all the desired temperature for each rate have been entered, or stop at the second 

desired temperature for the rate]. 

3. If there are hold times for the desired temperatures (for the rates): Press “COL” -> Press “FINAL 

TIME” -> enter the first desired hold time for the first rate (in min) using the number pad ->  Press “ENT” 

-> enter the second desired hold time  for the second rate (in min) using the number pad -> Press “ENT” -

> [keep repeating until all the desired hold times for each rate have been entered, or stop at the second 

desired hold time for the rate]. 
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Appendix C 

PeakSimple Operation Procedure  

 

When integrating the area of a target peak, a manual baseline can be drawn using the “Rubber 

Band” tool ( ) in the “Manual Integration” toolbar. Using the “Rubber Band” tool, the user 

can click at the beginning of the peak and drag the cursor to the end of the peak allowing a 

manual baseline to be created by the software, where the area above the drawn baseline is the 

area integrated. Using this method, the software will integrate the area of the peak and provide 

the data in the “Results” menu. When determining the height of the peak, the cursor is simply 

placed on top of the peak and a value in the right-hand corner of the software will indicate the 

height (mV); the value to the left of the height is the corresponding time point. 

 

 

Manual integration toolbar in PeakSimple software (version 4.51) for GC data. The “rubber band” 

tool for creating a manual baseline can be found in the 9th option down from the top of the toolbar. 
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To set an area reject value is set to 0.001 (allowing for the detection of smaller peaks), a 

component is created to allow for the integration of a target peak, with “Show total of all peaks” 

under the “In case of multiple peaks” option selected; this step is crucial as other options will 

provide varying results. This option can be found in the “Channels” menu, under “Integration”. 

 

 

Setting area reject in PeakSimple (version 4.51). Area reject is set to 0.001 for all GC sample runs.  

 

 

Setting integration parameters in PeakSimple (version 4.51). The option “Show total of all peaks” in 

the “Components” menu is selected for integration of all GC sample runs. 
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The voltage of the baseline (mV) must be equalized when the GC Buck is turned on thus, a series 

of steps must be done to create a positive baseline. Under the “Events” menu, then a “Reverse” 

event will be added. Once the events are added, the spacebar is pressed to reverse the baseline 

making it positive. The “Reverse” event is then removed after equalizing the baseline. A positive 

baseline is required to have peaks appear above the baseline.  

 

 

Adding an event in Peaksimple (version 4.51). The “Event details” window can be accessed from the 

“Channels” menu. 
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Setting “Reverse” event in PeakSimple (version 4.51). The “reverse” event is required to create a 

positive (mV) baseline, allowing peaks to show above the baseline. 

 

Once these parameters are set, a control file (.CON) can be created which allows the user to save 

these settings and use them for future GC runs. Controls files are saved and opened as how a file 

is typically saved and opened (in the “File” menu).  
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Accessing Control files in PeakSimple (version 4.51). “Open control file…” allows the user to load a 

saved control file, while “Save control file…” allows the user to save set parameters.  

 

When a GC run begins the start button (spacebar) must be manually pressed by the user to begin 

recording. Similar to how the “Reverse” event was added, a stop time can be set in PeakSimple 

in the “Events” menu which allows the software to end the recording (or the user can again press 

the spacebar to manually stop the recording); for the method used in this study, a stop time of 30 

min is used (Fig. 19). A “ZERO” event is added at 0 min to indicate the start of the GC run, and 

again at 30 min for the end of the run.  
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Setting a recording stop time in PeakSimple (version 4.51). A “zero” event at 0 min (start of the run) 

and again at 30 min (end of the run) is added for each GC sample run. 

 

PeakSimple files (.CHR) must manually be saved by the user after each run and can be saved at a 

destination of the user’s choice (recommended that chromatographs are saved in the same folder 

for ease of access during post analyses). Files can be accessed from the location where the user 

originally saved the .CHR file for post-run analyses. PeakSimple files (.CHR) can be saved on a 

USB drive allowing the user to analyze the chromatographs on a different computer, on which 

the PeakSimple software is installed. Although post-run analyses can be performed on a different 

computer other than the GC Buck, the same parameters and software version (4.51) must be 

used. Additionally, PeakSimple is a Windows exclusive software.  
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Appendix D 

GC Integrator Operation Procedure  

Operating Shimadzu GC-14a with Shimadzu CR601 Chromatopac Integrator 

*See Appendix B protocol for operation of Shimadzu GC-14a. 

1. To operate the Integrator, switch the power button on and wait a few seconds for the machine to power 

up.  

2. To begin recording, the “START/STOP” button on the integrator and “START” button on the 

Shimadzu GC-14a must be pressed at the same time.  

3. The recorder can be preset to stop recording by pressing “STOP.TM” followed by the desired stop time 

(For example, for a stop time of 30 min, the user would select: “STOP.TM” -> “3” –> “0”.  

4. The attenuation of the Integrator can be adjusted which will change the scale of the integration. In 

general, the larger the number, the more scaled in the integration is (beginning from 0 to 10 where each 

interval increases the scale by 10). To change the attenuation, press “ATTEN” then the value of 

attenuation you desire. 

 



 107 

Appendix E 

Standard Curve Raw Data 

1-Butanol standard curve raw data 
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Ethanol standard curve raw data 
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Isopropanol standard curve raw data 

 

 



 

  113 
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Acetone standard curve raw data 
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  117 

 

 

 

 



 118 

Appendix F 

Solvent Production Raw Data 

H. butylicus optimal conditions solvent data 
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H. butylicus with 5 mM butyrate solvent data 
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H. butylicus with 15 mM butyrate solvent data 
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H. butylicus with butyrate solvent comparison data 
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H. butylicus with 5 mM acetate solvent data 
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H. butylicus with 15 mM acetate solvent data 
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H. butylicus with acetate solvent comparison data 
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